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Preface

Who Should Read This Guide

This Cisco® Smart Business Architecture (SBA) guide is for people who fill a
variety of roles:

Systems engineers who need standard procedures for implementing
solutions

Project managers who create statements of work for Cisco SBA
implementations

Sales partners who sell new technology or who create implementation
documentation

- Trainers who need material for classroom instruction or on-the-job
training

In general, you can also use Cisco SBA guides to improve consistency
among engineers and deployments, as well as to improve scoping and
costing of deployment jobs.

Release Series

Cisco strives to update and enhance SBA guides on a regular basis. As we
develop a new series of SBA guides, we test them together, as a complete
system. To ensure the mutual compatibility of designs in Cisco SBA guides,
you should use guides that belong to the same series.

All Cisco SBA guides include the series name on the cover and at the
bottom left of each page. We name the series for the month and year that we
release them, as follows:

month year Series

For example, the series of guides that we released in August 2011 are
the “August 2011 Series”.

You can find the most recent series of SBA guides at the following sites:
Customer access: http://www.cisco.com/go/sba

Partner access: http://www.cisco.com/go/sbachannel
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How to Read Commands

Many Cisco SBA guides provide specific details about how to configure
Cisco network devices that run Cisco I0S, Cisco NX-OS, or other operating
systems that you configure at a command-line interface (CLI). This section
describes the conventions used to specify commands that you must enter.

Commands to enter at a CLI appear as follows:
configure terminal

Commands that specify a value for a variable appear as follows:
ntp server 10.10.48.17

Commands with variables that you must define appear as follows:
class-map [highest class name]

Commands shown in an interactive example, such as a script or when the
command prompt is included, appear as follows:

Router# enable
Long commands that line wrap are underlined. Enter them as one command:

wrr-queue random-detect max-threshold 1 100 100 100 100 100
100 100 100

Noteworthy parts of system output or device configuration files appear
highlighted, as follows:

interface Vlan64
ip address 10.5.204.5 255.255.255.0

Comments and Questions

If you would like to comment on a guide or ask questions, please use the
forum at the bottom of one of the following sites:

Customer access: http://www.cisco.com/go/sba
Partner access: http://www.cisco.com/go/sbachannel

An RSS feed is available if you would like to be notified when new comments
are posted.
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What's In This SBA Guide

About SBA

Cisco SBA helps you design and quickly deploy a full-service business
network. A Cisco SBA deployment is prescriptive, out-of-the-box, scalable,
and flexible.

Cisco SBA incorporates LAN, WAN, wireless, security, data center, application
optimization, and unified communication technologies—tested together as a
complete system. This component-level approach simplifies system integration
of multiple technologies, allowing you to select solutions that solve your
organization's problems—without worrying about the technical complexity.

For more information, see the How to Get Started with Cisco SBA
document:

http://www.cisco.com/en/US/docs/solutions/Enterprise/Borderless_Networks/
Smart_Business_Architecture/SBA_Getting_Started.pdf

Prerequisite Guides

BN

Design Overview LAN

Route to Success

To ensure your success when implementing the designs in this guide,
you should read any guides that this guide depends upon—shown to
the left of this guide on the route above. Any guides that depend upon
this guide are shown to the right of this guide.

For customer access to all SBA guides: http://www.cisco.com/go/sba
For partner access: http://www.cisco.com/go/sbachannel
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About This Guide

This additional deployment guide includes the following sections:

= Business Overview—The challenge that your organization faces.
Business decision makers can use this section to understand the
relevance of the solution to their organizations’ operations.

= Technology Overview—How Cisco solves the challenge. Technical
decision makers can use this section to understand how the solution works.

= Deployment Details—Step-by-step instructions for implementing the
solution. Systems engineers can use this section to get the solution up
and running quickly and reliably.

This guide presumes that you have read the prerequisites guides, as shown
on the Route to Success below.

You are Here

LAN and WLAN 802.1X

Deployment Guide Deployment Guide

What's In This SBA Guide
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Introduction

Business Overview

With an increasingly mobile workforce and a diverse number of platforms
used to gain access to the network, organizations are looking for ways to
monitor and control network access. An organization needs to know not
only who is accessing their wired and wireless networks, but also when the
networks were accessed and from where. In addition, with the wide adoption
of nontraditional devices such as smart phones and tablets, and people
bringing their own devices to access the network, organizations need to
know how many of these devices are connecting. With this information,
the organization can create policy to prevent connection by nontraditional
devices, limit connection to approved devices, or make access to network
resources easier for these non-traditional devices.

Organizations are being driven by industry and regulatory compliance (PCI,
Sarbanes-Oxley) to be able to report on who is accessing the organization’s
information, where they are accessing it from, and what type of device

they are using to access it. Government mandates like Federal Information
Processing Standard (FIPS) and Federal Information Security Management
Act (FISMA) are also requiring agencies and entities working with govern-
ment agencies to track this information. In some cases, an organization may
choose to limit access to certain information to adhere to these regulations.

This information is also key data that can be used to generate advanced
security policies. Organizations see this as a daunting task requiring the use
of several advanced technologies and often delay implementing a solution
simply because they don't know where to begin.

This guide is the first step in deploying a complete identity-based archi-
tecture. Future projects will address additional use cases that will focus on
the features that will provide for things like enforcement, guest access, and
confidentiality.

Technology Overview

Cisco ldentity Services Engine (ISE) is an identity and access control policy
platform that enables enterprises to enforce compliance, enhance infra-
structure security, and streamline their service operations. Cisco ISE is a
core component of Cisco TrustSec. Its architecture allows an organization to
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gather real-time contextual information from the network, users, and devices
to make proactive policy decisions by tying identity into network elements
like access switches, wireless controllers, and VPN gateways.

This deployment uses Cisco ISE as the authentication and accounting
server for the wired and wireless networks as well as for remote access VPN
users who connect using RADIUS. Cisco ISE acts as a proxy to the existing
Active Directory (AD) services to maintain a centralized identity store for all
network services.

In addition to authentication, this deployment uses Cisco ISE to profile
devices to determine the specific type of devices that are accessing the
network. This is done by examining network traffic for certain criteria based
on certain characteristics. Cisco ISE currently has probes for Dynamic
Host Configuration Protocol (DHCP), HTTP, RADIUS, Domain Name System
(DNS), Simple Name Management Protocol (SNMP) traps and queries, and
Netflow. To analyze the traffic, the engine can be deployed as an inline
policy enforcement device or the traffic can be forwarded to the engine.
As an example, the network infrastructure is configured to send copies of
the DHCP requests to Cisco ISE for analysis. The engine then evaluates
the DHCP request and can identify the device based off of the data in the
request. For example, Cisco IP Phones are identified by their DHCP class
identifier.

In the LAN, there are three modes for deploying TrustSec: monitor mode,
authenticated mode, and enforcement mode. Cisco recommends a phased
deployment model that can allow for limited impact on network access while
gradually introducing authentication/authorization on the network. This
document covers the deployment of monitor mode both at the headquarters
site and the remote sites, with Cisco ISE being centralized in the data center.
The monitor mode deployment in use deploys two features within [OS on
the switches in the access layer at both the headquarters sites as well as the
remote sites. The first is MAC Authentication Bypass (MAB), which authen-
ticates the device on the switch port by the MAC address. Monitor mode
logs the MAC addresses that connect and grant access to any device that
connects. The second feature is 802.1X open mode, which allows the switch
port to give unrestricted access to the network even though authentication
and authorization have not been performed. This enables the deployment of
identity without affecting existing connectivity. This phased approach allows
us to prepare for moving to another mode (for instance, authenticated or
enforcement) in the future. In the organization, these switch configurations
will be managed by Cisco LAN Management Solution (LMS) 4.1 and the

new Identity WorkCenter. Cisco LMS simplifies the deployment of identity
by performing a network readiness assessment for an identity deploy-
ment, providing templates for the various modes—monitor, authenticated,

Introduction



enforcement—and providing a step-by-step wizard to configure the various
components required.

You accomplish integrating Cisco ISE into the wireless network by using
Cisco ISE as the RADIUS server for wireless 802.1X authentication and
accounting. You configure this on every wireless LAN controller (WLC) in
the network, at both headquarters and the remote sites. The one exception
is for the controller used for guest access. You can also configure the WLCs
to forward DHCP requests to Cisco ISE to enable the profiling of wireless
endpoints.

Figure 1 - Cisco ISE integration into Cisco SBA

Certificate Wireless LAN (" Remote Access VPN )

Authority Controller
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Step 1: Boot the Cisco ISE and then, at the initial prompt, enter setup. The
installation begins.

The deployment described here bases all IP addressing off of the SBA for

Enterprise Organizations — Borderless Networks LAN Deployment Guide. ialaiaiaieiiaiiaiateiab il ettt
Any IP addresses used in this guide are examples; you should use address- Please type "setup’ to configure the appliance
Ingt pp y ‘ localhost login: setup_

Device IP address Hostname

Primary Cisco ISE 10.4.48.41 Ise-1.cisco.local

Secondary Cisco ISE 10.4.48.42 ise-2.cisco.local

Step 2: Enter the host name, IP address, subnet mask, and default router of
the engine.

Enter hostname[]: ise-1
Enter IP address[]: 10.4.48.41
Enter IP default netmask[]: 255.255.255.0

Deploying Identity Services Engine

1. Set up initial primary engine Enter IP default gateway[]: 10.4.48.1
2. Setup the secondary engine Step 3: Enter DNS information.
3. Configure certificate trust list Enter default DNS domain[]: cisco.local
_ ) Enter primary nameserver[]: 10.4.48.10
4. Configure Cisco ISE deployment nodes ,
Add/Edit another nameserver? Y/N : n
5. Install Cisco ISE license
6. Configure network devices in Cisco ISE
7. Configure Cisco ISE to use Active Directory
8. Disable IP Phone authorization policy



Step 4: Configure time.

Enter primary NTP server([time.nist.gov]: ntp.cisco.local
Add/Edit secondary NTP server? Y/N : n
Enter system timezone[UTC]: PST8PDT

Timezone abbreviations can be found in the Cisco ldentity
Services Engine CLI Reference Guide, Release 1.1:

http://www.cisco.com/en/US/docs/security/ise/1.1/cli_ref_guide/
ise_cli_app_a.html#wp1571855

Step 5: Configure an administrator account.

You must configure an administrator account in order to access to the CLI
console. This account is not the same as the one used to access the GUI.

Enter username[admin]: admin
Enter password: [password]
Enter password again: [password]

Cisco ISE completes the installation and reboots. This process takes several
minutes. You will be asked to enter a new database administrator password
and a new database user password during the provisioning of the internal
database. Do not press Control-C during the installation, or it will abort the
installation.

Do not use ’Ctrl-C’ from this point on...

Uirtual machine detected, configuring UMware tools...
Installing applications...

Installing ise ...

Executed with privileges of root

The mode has been set to licensed.

Application bundle (ise) installed successfully

=== Initial Setup for Application: ise ===

Welcome to the ISE initial setup. The purpose of this setup is to
provision the intermal ISE database. This setup requires you create
a database administrator password and also create a database user password.

The primary engine is now installed.

February 2012 Series

Procedure 2 Set up the secondary engine

The procedure for setting up the secondary engine is the same as the
primary, with the only difference being the IP address and host name config-
ured for the engine. To set up the secondary engine, follow Procedure 1 and
use the values supplied in the table for the secondary engine.

Configure certificate trust list

The two engines use public key infrastructure (PKI) to secure communica-
tions between them. Initially in this deployment, you use local certificates
and you must configure a trust relationship between the primary and sec-
ondary engines. To do this, you need to import the local certificate from the
secondary engine into the primary engine.

Step 1: In your browser, connect to the secondary engine’s GUI at http://
ise-2.cisco.local.

Step 2: In Administration > System, select Certificates.

Step 3: In the Local Certificates window, select the local certificate by
checking the box next to the name of the secondary engine, ise-2.cisco.
local, and then click Export.

Step 4: Choose Export Certificate Only, and then click Export.

Step 5: When the browser prompts you to save the file to a location on the
local machine, choose where to store the file and make a note of it. You will

be importing this file into the primary engine.

Step 6: In a browser, access the primary engine’'s GUI at http://ise-1.cisco.
local.

Step 7: In Administration > System, select Certificates.

Step 8: In the Certificate Operations pane on the left, click Certificate
Authority Certificates, and then click Add.

Deployment Details
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Step 9: Click Browse next to the Certificate File field, and then locate the

certificate exported from the secondary engine. It has an extension of .pem.

Step 10: Click Submit.

Configure Cisco ISE deployment nodes

You can configure the functions of Cisco ISE—administration, monitor-
ing, and policy service—to run all on a single engine or to be distributed
amongst several engines. For this example installation, you will deploy a
primary engine that performs all three functions and a secondary engine
that acts as a backup for the primary.

Step 1: Connect to http://ise-1.cisco.local.
Step 2: From the Administration menu, choose System, and then choose

Deployment. A message appears notifying you that the node is currently
stand-alone.

This node is in Standalone mode. To
register other nodes, you must first
ediit this node and change its
Administration Role to Primary

Step 3: In the Deployment pane, click the gear icon, and then select Create
Node Group.

In order for the two Cisco ISE devices to share policy and state information,
they must be in a node group. The nodes use IP multicast to distribute this
information so they need to be able to communicate via IP multicast.

Step 4: Configure the node group with the node group name ISE-Group
and the default multicast address of 228.10.11.12.

Step 5: Click Submit. A pop-up window lets you know the group was cre-
ated successfully. Click OK.

Step 6: In the Deployment pane on the left, expand Deployment. A list of
the current deployment nodes appears.

Step 7: Click ise-1. This enables you to configure this deployment node.

Step 8: Under the Personas section on the General Settings tab, click Make
Primary, which is next to the Administration Role.

Step 9: Include this node in the ISE-Group node group by choosing it from
the pull-down menu.
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Step 10: Click the Profiling Configuration tab.

Deployme

nt Details



Step 11: This example uses DHCP and RADIUS. Select the box next to each
to enable these methods, use the default parameters, and then click Save.

¥ DHCF

Interface
| GigabitEthemet 0 v

Port
|67 |

Description
[ DHCP |

¥ RADIUS

Description
[ RADIUS |

Step 12: In the Edit Node window, click Deployment Nodes List. The
Deployment Nodes window appears.

Step 13: Click Register, and then choose Register an ISE Node.

aliln
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ise-l  admin  Logout  Feedback
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—_—— = .
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- =E &.
~ o Deployment.
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Deployment Nodes
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/e DiRegster « || @ poon @ npon LI I

[ Hostn, Register an 15E Node

s Personas Role(s)
Admiristration, Moritoring, Policy Serice  PRI(A), PRI(M)

Step 14: Enter the IP address or host name of the secondary Cisco ISE and

the credentials for the admin account, and then click Next.
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Step 15: Configure ise-2 to be the secondary engine in the group by
making sure that all the boxes are selected to enable all personas and that
this unit is the secondary. Choose the node group ISE-Group from the
drop-down list.

Step 16: Click Submit. The node registers and a pop-up window displays
letting you know that the process was successful. Click OK.

€ISEO  Identity Services Engine et admin Logout  Fesdback

0 Task Navigator ~ €)

7 System | &2 Identity Management [ Network Resources 2§ Guest Management

Depioyment ) Licensng  Certficates  Loggng  Mantenance  Admin Access  Settings

Deployment Nodes it > Configure Node

Deployment

. | Resister ISE Node - Step 2: Configure Node

Hostname jse-2
FQDM ise-2.cisco Jocal
1P Address 10.4.48.42

Hode Type Identity Services Engine (ISE)
> Personas

" D adminstration Role SECONDARY

M Moritoring Role| sECONDSRY | Other Monitaring Nodle| ise-1

Policy Service

Enable Session Services ¢
Include Node in Nodde Group [ 15E-Group BiG

Enable Profiing Service

| ]

Cancel |

Step 17: In the Deployment Nodes window, click ise-2, click the Profiling
Configuration tab, and then configure the DHCP and RADIUS options in the
same way you did for the primary engine.

Step 18: Click Save.

Both Cisco ISE units are now configured as a redundant pair.
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Install Cisco ISE license

Cisco ISE comes with a 90-day demo license for both the Base and
Advanced packages. To go beyond 90-days, you need to obtain a license
from Cisco. In aredundant configuration, you only need to install the license
on the Primary Administration Node.

Step 1: Mouse over Administration, and then, from the System section of
the menu, choose Licensing.

Notice that you only see one node here since the secondary node does not
require licensing.

Step 2: Click the name of the Cisco ISE server. This enables you to edit the
license details.

Step 3: Under Licensed Services, click Add Service.

Step 4: Click Browse to locate your license file, and then click Import.

ervices Engine el adnin Logout Fescback

&% Syem | & ] o)
Deployment  ("Licensing ) Certfcatss  Logain

mmmmmmmm

If you have multiple licenses to install, repeat the process for each.

When installing a Base license and an Advanced license, the
Base license must be installed first.
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Configure network devices in Cisco ISE

Configure Cisco ISE to accept authentication requests from network
devices. RADIUS requires a shared secret key to enable encrypted com-
munications. Each network device that will use Cisco ISE for authentication
will need to have this key.

Step 1: Mouse over Administration, and then, from the Network Resources
section of the menu, choose Network Devices.

Step 2: In the left pane, click Default Device.

Each network device can be configured individually, or devices
can be grouped by location, by device type, or by using IP
address ranges. The other option is to use the Default Device

to configure the parameters for devices that aren’t specifically
configured. All our network devices have to use the same key, so
for simplicity, this example uses the Default Device.

Step 3: Enable Default Network Device Status by choosing Enable from the
pull-down menu.

Step 4: Enter the RADIUS shared secret, and then click Save.

alln
€ISEO  Identity Services Engine el sdnin Logout Feedback

A Home  Operation iy v Administiation v
o system [ 2}

: I (o)
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Configure Cisco ISE to use Active Directory

Cisco ISE will use the existing Active Directory (AD) server as an external
authentication server. First, you must configure the external authentication
server.

Step 1: Mouse over Administration, and then, from the Identity
Management section of the menu, choose External Identity Sources.

Step 2: In the left panel, click Active Directory.
Step 3: On the Connection tab, configure the connection to the AD server
by entering the AD domain (for example, “cisco.local”) and the name of the

server (for example, “AD1"), and then click Save Configuration.

Step 4: Verify these settings by selecting the box next to the node, and
then clicking Test Connection and choosing Basic Test.

Step 5: Enter the credentials for a domain user and click OK.

Test Cornection x

= User Name: [employeet

*Password

o ==

Step 6: Select the box next each node, and then click Join.
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Step 7: Enter the credentials for a domain administrator account. The Cisco
ISE is now joined to the AD domain.

Ioin Domain x

= User Name: [Administratar

*Pagsword: [sessssse

(e |

Next, select which groups from AD that Cisco ISE will use for authentication.

Step 8: Click the Groups tab, click Add, and then click Select Groups from
Directory.

Step 9: Search for the groups you wish to add. The domain field is already
filled in. The default filter is a wildcard to list all groups. Click Retrieve
Groups to get a list of all groups in your domain.

Step 10: Select the groups you want to use for authentication, and
then click OK. For example, for all users in the domain, select the group
<domain>/Users/Domain Users.

Selert Directory Groups
This dialog is used to select graups from the Directory. Click Retrieve Groups.. to read directory
Use *for wildcard search (ie. admir®). Search filter applies to group name and not the fully qualified path

Domain; | cisconocal

Fiter. [+ Roetrieve Groups...| Number of Groups Retrieved: B4 (Limitis 100)
O name

ciseo.InealiUsersiDHGP Administrators 4
ciseo.IneallUsersiDHCP Users

ciseo.IoealiUsersiDenied RODG Password Replication Group
cisen. IoealiUsersiDnsAdming
ciseo.IneallUsersiDnsUpdateProxy

cisen.loealiUsersiDomain Adrmins

ciseo.IocaliUsers/Domain Computers
ciseo.loealiUsersiDomain Controllers
ciseo.InealiUsersiDomain Guests

ciseo.InealiUsersDomain Users

ciseo.IneallUsersfEnterprise Admins
ciseo.IneallUsersfEnterprise Read-only Domain Conrollers
ciseo.InealiUsersiGroup Policy Creatar Owners

cisco.ncallUsers/POS-Users _lﬂ
3

O
O
O
O
O
O
O
O
O
O
O
O
rl

o e

Step 11: Click Save Configuration.
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Disable IP Phone authorization policy

There is a default policy in place for Cisco IP Phones that have been pro-
filed. This profile applies a downloadable access list on the port to which the
phone is connected. Since there is no policy enforcement taking place, this
rule should be disabled.

Step 1: On the menu bar, mouse over Policy, and then click Authorization.

Step 2: Click Edit for the Profiled Cisco IP Phones rule, click the green
check mark icon, choose Disabled, click Done, and then click Save.

aluailie
CISCO  Identity Services Engine el admn Logout Feedback
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Enabling Visibility to the LAN

1. Configure MAC Authentication Bypass
Configure 802.1X for wired users
Enable RADIUS in the access layer
Enable identity

Disable port security timers

o o s ® N

Configure profiling for the LAN

Cisco ISE is now configured for identity. The next step is to configure the
switches for identity by using Cisco LMS 4.1 and the Identity Workcenter.

Configure MAC Authentication Bypass

MAC Authentication Bypass (MAB) allows you to configure specific machine
MAC addresses on the switch to bypass the authentication process. For
monitor mode, this is required, since you aren't enforcing authentication.
MAB will be configured to allow any MAC address to authenticate.

Step 1: Mouse over Policy, and then choose Authentication. The Policy
Type is Rule-Based.

There are already two default rules in place, MAB and Dot1X.
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Step 2: Use the default MAB policy. Click the black triangle to the right of
the and... of the MAB rule. This brings up the identity store used for the MAB
rule.

€ISCO  Identity Services Engine ise-l  admin  Logout  Feedback

v Administration v ©0 Task Navigator ~ €3

[2] Muthentication | [8] Autharization  [4) Profing [@) Postwe [ Client Provisioning [ Security Group Access g% Policy Elsments

Authentication Policy =
Define the Authentication Policy by selecting the protocols that 1SE should use to commuricate with the network devices, and the idertity sources that it should use for authentication
Policy Type () Simple (8 Rule-Based
> | [Mem | 1F [ wired_mag < | alow protocols [Alowed Protocal : Default Netwe® | and.. |+ & actons
Default use | Internal Endpaints & G Actions
-~ [Dotix | of [ wired_soz.1x | allow protocols [Alowed Protocel : Default Netwes) | .. & actors
Default Ruies (If na match) allow protocols [Alowed Protocel : Default Netwd | and use idertity source : [ internal Users  <» & actions ~

Next, change the options on the Internal Users database, which is used for
profiling.

Step 3: Click the + next to Internal Endpoints. In this example deployment,
we are allowing all endpoints to authenticate. If the MAC address isn't found
in the database, you need to bypass authentication and continue. For the
authentication failed and user not found options, choose Continue from the
pull-down menu.

Step 4: Click anywhere in the window to continue, and then click Save.

alialn
CISCO  Identity Services Engine st admin  Logout  Feedback
|2) Authentication | [s] Authorization  [4) Profing  [@) Posture [ Client Provisioning |5} Secuity Group Access ), Policy Elements
Authentication Policy =
Defire the Authentication Policy by selacting the protocols that ISE shold Lse to cammunicate with the network devices, and the identity saurces that it sould Use for autihentication,
Policy Typs () Simple ) Rule-Based
-~ | [mag | < 1F [ rired_mag < | allow protocols [ Alowed Protocal : Defadlt Netw) | ad.. O Actions ~
« | [ wiredDot1x ]+ 1 [ wired_soz1x | allow protocols [alowed Protocol : Defadit Netwi | and... & actions -
Default use [ Intemal Users = O Actions -
Options
If authentication failed
Default Ruls (If no match) : dlow prot Ifuser nat fourd [Reject | - | @& actons -
1f process faled s
Nots: For authentications Lsing PEAP, LEAP, EAP-FAST or RADIUS MSCHAP
it is N0t possible to continue processing when authentication fals or user is not found, -
If continue option is sslected in these cases, requests wil be rejected,
I
€Y Help Alarms @ 00 0@ 2 | £ Notifications (0)
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Configure 802.1X for wired users

There is already a Dot1X rule configured on the engine. Although in this
example deployment you aren’'t deploying any wired endpoints with 802.1X
supplicants at this point, you should still configure this rule to prepare for the
next phase of an identity deployment.

Step 1: Mouse over Policy, and then, from the menu, choose
Authentication.

Step 2: To differentiate this from a wireless 802.1X rule, rename the rule
Wired-Dot1X.

Step 3: Click the black triangle to the right of the and... of the Wired-Dot1X
rule. This brings up the identity store used for this rule.

The default identity store is the internal user database. For 802.1X, use the
Active Directory server that you defined earlier.

Step 4: Click the + symbol next to Internal Users. This enables you to edit
the identity store and the parameters.

Step 5: From the Identity Source drop-down list, choose the previously
defined AD server AD1, use the default options for this identity source, and
then click anywhere in the window to continue.

Step 6: Click Save.

€IS€0  Identity Services Engine ise-l  admin Logout  Feedback

©0 Task Mavigatar » €3

ns v Poicy v Administration v

|2} Authentication | [®] Autharization [ 4) Profing  [@) Posture [k Client Provisioning | ) Security Group Access . Policy Elements.

Authentication Policy =

Define the Authentication Palcy by selecting the protocals that ISE should use to communicate with the network devices, and the idertity sources that it should use for authentication.
Policy Type O Simple @ Rule-Based

- | [mem | o1t [ vwired_maB 45 | allow protoccls [Allowed Protocol : Default Netwd | and... ) £ actions -

- | [wiredDot1x ] 11f [ wired_soz1x | dllow protacols [alowed Protocol : Defadlt Netwes) | and... & Actions -

] Default use [ Intemal Users = & Actions v
Inentity Saurce
Options

If authentication faled[Refect |+ ]
If user not found [Reject | ~ | £ Actions v
If process failed —
Nate: For authentications using PEAP, LEAP, EAP-FAST or RADIUS MSCHAP

it is not possible to continue processing when authentication fals or user is not found. o
If continuie aption is selecte in these cases, requests wil be rejecte:

[~] Default Rule (If no match) allow prot
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Step 6: In the pop-up window, enter 10.4.48.41 for the RADIUS server IP
Procedure 3 Enable RADIUS in the access layer address, and then click Save and add another.

Step 7: Enter 10.4.48.42 for the second RADIUS server, and then click

Step 1: Connectto Cisco LMS with a web browser, for example: https://Ims. Save. The RADIUS server group has been configured.

cisco.local.

Step 8: In the AAA Configuration section, make sure that only Enable for
802.1X / MAB AAA is selected. A warning message about not configuring
AAA for Web authentication appears. Click OK.

Step 2: Mouse over Workcenters, and then, from the Identity section,
choose Getting Started. This shows the network’s Identity Readiness
Assessment, which verifies that the software versions support the identity

features and that the switches are capable of running RADIUS. Step 9: Click Next to proceed to the next step.

. Cisco Prim

o
LAN Management Solution admin LogOut About  Stemap Feechack Help | [ Search > Wi e
Configuration v Reports v Admin v W ers LAN Management Solution

Werk Canters = Identiy > Getling Starte £3Dec 2011, 11118 PST

LogOut Abouk Stemep Feecback He | ML+ Search >

5 » Lty = Cor

=  Configure RADIUS 13 Dec 201, 11:22 PST

configure RADIUS

Getting Started

” Navigat
Introduction Javigator

Introduction to the Cisco TrustSec Identity Solution

Cisco TrustSec Identity-based Networking Services (IBNS) s an integrated solution consisting of several Cisco Dashboard The Cisco TrustSec Identity solution expects access switches to have a RADIUS server configuration for authentication and
proclcts that offer authentication, access contra), and Lser polcies to secure network connectiity and resources. 55 Getting Started autharization, T following workfow feclitates RADIUS server configuration and makes the device identity-capable.
Cisco TrustSec Identity helps enterprises with the abiity to increase user productivity, reduce operating costs, Getting Started
increase wisiility and enforce policy compliance. For more information on Cisco TrustSec and IBNS, click here. 23 RADIUS Capable Devices
0 Identity Capable Devices. Rearliness Assessment Select Devices v

Identity-readiness assessment for your network @ Software Incapable Devices + corfare
0 Hardware Incapsble Devices ! Gonfigure RADIUS Server

Configure RADIUS

Click on any of the pie chart slces to display device detals based on the Identity-reaciness assessment for your
network Prepare for Identity Provisioning Enabie Interfaces

Manage Devices Radius Configuration

P Configure RADIUS
RADIUS host O Single (® RADIUS Group

23 devices need RADIUS Configuration » Reports
" Provision Identity in Network Jobs Al feks are required,
RADIUS Capable Devices
23 (100%) You can creste only single RADIUS group, which can contai multiple RADIUS servers
P Enable Interfaces .
0 dlevices are ready for proviioning Identity P Pame [SE-Grow !

dd the detals of the RADIUS servers that wil be part of this RADIUS group. The order of addition s important s the frst
You have 23 RADIUS Capable devices entry acts as the primary RADIUS, the second as the secondary and so on.

These devices are running with RADIUS Capable images, buit RADIUS is not configured on these devices.
RADIUS Server Details

RADIUS Capable Devices — Delete | i Adg P Fiter
[ confgureRapIUs | 7 Fitter Server Name or IP Address Authentication part Accounting port
[ pevice name 1P acichess. Device type: Running image version O 144841 1645 1646
RS206- = O 1044842 1645 1646
] ) MRS Cisco Catalyst 2960 stack 12.2(58)5E2
RE212-
O Bioeny cicolocy 105168252 Csco 3780 Stack 12.2(58)5E2
R5203-
| ) RS Cisco 3750 Stack 12.2(58)5E2
RE212-
O otes cicooea 1051705 Cisto Catabyst 2060 stak 12.2(58)5E2
RS210-
O ot ciicoloca 1051485 Cisco 3750 Stack 12.2(58)5E2
AAA Configuration
RS204-
O et cicolocs 105605 Cisco Catalyst 2960 stack 12.2(58)5E2 5
Enable for 802.1X f MAB AAL.
[ Enable Asa for Web Authentication.
B videos TAC Service Requests | Alarms @ 150 ¥ 0 B 0 (previous | (_Mext | | Finsh | [ Cancal |

Schedule Deployment

Next, configure identity by enabling RADIUS on the switch.

I videos TAC Service Requests | Alarms @ 153 W 0 B 0

Step 3: In the RADIUS-capable devices table, select the switches for which
you want to enable RADIUS, and then click Configure RADIUS.

Step 4: Selectthe RADIUS Group button, and then fill in the fields. Enter
ISE-Group for the RADIUS group name, and then use the value used in
previous procedures for the Shared Key.

You can review the CLI commands that will be pushed to the
switch by clicking Preview CLI.

Step 5: Inthe RADIUS Server Details section, click Add.
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Step 10: Enter a job description, and then click Finish to deploy
immediately.

Step 11: When you receive the warning regarding the addition of AAA
commands, click Yes, and then click OK on the pop-up window generated
after the job is created.

Enable identity

The identity configuration enables monitor mode on the switch. This enables
both 802.1X and MAC Authentication Bypass, (MAB) however no authentica-
tion policy is enabled. This allows the ports to be monitored with no disrup-
tion to current network activity.

Step 1: Mouse over Work Centers, and then, under the Identity section,
choose Configure.

Step 2: In the Navigator pane on the left, click Enable Interfaces.

Step 3: Choose the switch that was previously configured for RADIUS from
the list, select All Groups in the port group selector, and then click Next.

Wil Ciseo Prime
CISCO  LAN Management Solution admin LogOUE About  Stemap Feschack Hep | ELw Seach >
vation v Reports v ers &
Warks Gentes > ity » Canfigurs ~ Enable I 130sc 2013, 1127 PST
Navigator Enable Interfaces for Identity
Dastboard Select Devices and Port Groups
Getting Started
Readiness Assessment Select devices from the ist of Identity Canable devices, and Select the port groups associated with tese devices.
~ Configure oty o D )
Configure RADIUS iy GG D b Port Group Selector
Enable Interfaces ¥ Fiter = A&l Groups
Manage Devices Display Name P Acidress Device Type 1 Ghps Ethemet Ports
Rs201-
© o
— o 105445 Cisco Catalyst 2060 stack 10 Gops Ethernet Ports
10 Mpps Ethernet Ports
Jobs 100 Mbps Ethemet Parts
Arress Ports
DMP Ports
End Hosts
1P Phones
IPWSC Ports
Previows | ((Next ) [ Fnish | ([Cancel )
Review Port Groups
Configure dentity
Schedule Deployment
H videos TAC Service Requests | Alarms @ 152 ¥ o B o
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Step 4: Select the check box next to the ports for which you want to enable
identity, and then click Next.

o  Cisca Prime
©  LAN Management Solution

admin LogOut  About Sitemap Feedback  Help B~ search >

Configuration v Reports v Admin v

tilork Centers > Identity » Canfigure = Enable Interfaces 13 Der 2011, 11:27 PST

Navigator Enable Interfaces for Identity

Dashboard Select Devices and Port: Groups <

Getting Started Review Port Groups

Readiness Assessment Ve the ports and unselect the ports that you wish to excude.

 Configue

i Selected Devices Assoriated Ports
Configure RADIUS
Enable Intert Display Name: Port hame Description
nable Interfaces
® RS201-429605,cisc0.|ocal Gi1/0j2 GigahitEthermet 1/0/2 Q
Manage Device: aLfo/ie GigabitEthermet 1i0y 18
» Reports Gi1/D/19 GigabitEthernet1/0/19
. Gi1/0/1 GigahitEthernet 1/0/1
Jobs.
GIL/0/16 GigabitEthermet1/0/15
Gi1/0j17 GigabitEthernet1/0/17
Gi1/0j6 GigahitEthermet1/0/6
Gi1/0/14 GigabitEthernet1/0/14
Gi1/0/15 GigahitEthernet1/0/15
M ciinrs CinslhitCtnnt1 OIS |

[Previous | [[Next ] | Finch | [_cancel ]

Configure Ientity

Schedule Deplayment

Next, configure monitor mode.

Step 5: Move the Security Mode slider to Monitor, which is the default.
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Step 6: In the Authentication Profile section, select 802.1X, then MAB in the Step 8: Give the deployment job a description in the Job Description field,
Define Authentication Profile slider, make sure MultiAuth is selected in the and then click Finish to submit the job. Click OK.

Define Host Mode section and No Change is selected for Action to be taken

on security violation, and then, in the MAC Configuration section, make sure

only Enable MAC Move is selected.

wtfraalie  Cisco Prime
€IS€O  LAN Management Solution admin LogQut  About  Sitemap  Feedback  Help
oo Tamr o Dmege Goidme s Eoo TR = You can review the CLI commands that will be pushed to the
Wk Cantrs = [arliy = Corfiaure - Enable Interfaces 13Dec 2001, 127 P57 switch by clicking Preview CLI.
Navigator Enable Interfaces for Identity
Dashhoard Selact Devices and Port Groups 2
Getting Started Review Port Groups 4
alualis  Cisca Prime
¥ Configure €ISCO  LAN Management Solution admin Logout About  Stemap  Feedback  Help
Configure RADIUS Identity modle to be configured T e T
Enable Interfaces Chooge the Security mode based on the |evel of security reguired in the devices Walues shown as selected are the defaultvalues.
work Ce dertity = Corfigure = Enable Interfacas 12 Dec 2011, 11:33 PST
Manage Devices §
Navigator Enable Interfaces for Identity
Select the security mode based on the level of security you wish to implement in your netwark,, More Detals &
» Reports ety ok Dashboard Select Devices and Port Groups 7
I 1
Jobs WMaritor Low impact High Getting Started Review Port Groups 1
secuity Readiness Assessment ity Wiy &
Authentication profile and host mode Configure RADIUS
Choose authentication profiles, host mades and action to be taken in case of violations Enable Interfaces Scheduler
Manage Devices * Indicates required field
Define Authentication Profie @ Immedate Iob Descriation*
The host mode determines the number of hosts that can be authenticated on a given part.. More Detals > Jbs 8 Sva“‘/ "
ekly
Define Host Mode Single Hast Multinle Host ® Multiauth G Manthly
Multidomain Mo Change
T [ Enable job password
nat
Select the action to be taken when a port security violation is detected dus to the following reasons.. More
Detals > [ Fail on mismatch of config versions Login Username
§ [ Sync archive before job execution Login Password
Action to be taken on security violation O Restrict O Protect O Shutdown (8 Mo change [ cony running config to startup
Enable Password
Preview CLL | | Previous | | Mext Finish | | cancel |
MAC Configuration
H Videos TAC Service Requests | Alarms @ 155 ¥ 0 B o
MAL move,/replace SNMP MAC notification . . . .
The global commands added to the switch configuration at the completion
Enable MAC move of replace., Mare Detals > Enahie SHMP natification for MAC addition or
removal., Maore Detals  » i
Enatle MAC rrove of the previous two procedures are as follows.
[ Matify MAC addition
[ Enable MAC replace .
1 hotify MaC remaval aaa group server radius ISE-Group
server 10.4.48.41
Additional Configurations
server 10.4.48.42
If you have selected low impact mode and if ACL is not configured on the device, vou.. More Detals  »
[ Advanced aptions
P MNext Firish Cancel 4 4
ey (oo ( Fh | (aancels) aaa authentication dotlx default group ISE-Group
Schedus Deplojment aaa authorization network default group ISE-Group
e S e e B aaa authorization configuration default group ISE-Group

aaa accounting dotlx default start-stop group ISE-Group

Step 7: Click Next. Identity configuration is complete.
Next, you must create a deployment job in order to deliver the configuration authentication mac-move permit
to the switch. dotlx system-auth-control
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radius-server host 10.4.48.41
radius-server host 10.4.48.42
radius-server key [key]

The interface commands added at the completion of this procedure are as
follows.

interface [interface]

authentication host-mode multi-auth
authentication open

authentication order dotlx mab
authentication port-control auto
mab

dotlx pae authenticator

Disable port security timers

The current Cisco SBA design incorporates the use of port security to

provide a level of security and prevent rogue devices from being connected.

However, 802.1X also provides this functionality and there can be conflicts
when both are enabled on a port at the same time. This is particularly true of
inactivity timers since both port security and 802.1X each have their own set
of timers. The conflict causes 802.1X to re-authenticate every time the port
security time out is reached. To avoid this issue, port security timers need to
be disabled.

Step 1: Connect to the Cisco LMS server by browsing to https://Ims.cisco.
local.

Step 2: Mouse over Configuration, and then choose NetConfig under the
Tools heading. This opens the Job Browser.

Step 3: Click Create. This enables you to configure a new job.

Step 4: Select Port based, and then click Go.
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Step 5: Click the + symbol next to the All Devices tree, select the switch
you are configuring, and then click Next.

In this example, only one switch is being configured, but you can
select multiple switches to accommodate a large deployment.
The Group Selector allows you to choose switches by pre-
defined groups or by model.

Step 6: Select Define an Ad-Hoc Rule. This brings up a new screen.
Step 7: For the ad-hoc rule, select Port for the object type.

Step 8: From the Variable drop-down menu, choose
Identity_Security_Mode.

Step 9: For the Operator, choose =, and for the Value, select Monitor.

Step 10: Click Add Rule Expression, and then click Next.

alual  Cisco Prime

€is€o  LAN Management Solution admin  Log OUENARSLE gailemon Foct i M B~ Search <>

MyMenu v Monitor v Inventory v Configuration v Reports v  Admin v Wor

15 Dec 2011, 1151 PST
Mode: PORT Groups
o 1. Device and
Group Selector Port Groups
0 2. Groups € Select Custom Group(s) ' Define an Adhoc Rule
adhoc Rule

0 3. Tasks
0 4. Add Tasks
O 5. Set Schedule

Object Type: Variable: Operator; Yalue:

Identity_Security_Made x|[= =] [ursecured =]
¥ | add Rule Expression |

0 6. View Job Work
Crder

Rule Text
Fort.Identicy Security Mode = "Honitor”

Cherk Syntax || Include || Exclude |

-Step2of6 -

Back Mext Finish
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H videos
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Step 11: In the Task Selector, select Adhoc Task, and then click Next. Step 14: After returning to the Add Tasks window, click Next.

Step 12: Click Add Instance, and then, in the new window, add the CLI AL T —— min 1og oY ga N
Commaﬂds necessary tO remove -the port SeCUrity COﬂﬂguratiOﬂ. MyMenu v Monitor +  Inventory v Configuration v Repo Admin v T
no switchport port-security aging time (e — Add Tasks
no switchport port-security aging type e e il
® 2. Groups Applicable Tasks added Instances

& 3. Tasks — —
O 4. add Tasks

no switchport port-security violation

O 5. Ser Scheduls
Options

Step 13: Click Applicable Devices, select the switch to apply this configu- o 6 vew ok
ration to, click Close, and then click Save.

Adhoc Task Configuration

[ add mnstance | Edt.. || viewar. |[viewports || Delete |

10S Parameters - o — o (—
Commands

Step 15: Fill in a description for the job, and then click Next to submit the

no switchport port-security aging time ) : .
job for immediate deployment.

no switchport port-security aging type

CLI Commands: . ) . .
no switchport port-security violation

Step 16: Click Finish, and then click OK when you receive a notice that the
job was submitted successfully.

Raollback Commancds:

[ Applicable Devices... ]

[ Save ” Reset ” Cancel ]
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Configure profiling for the LAN

One of the ways Cisco ISE profiles endpoints is by examining DHCP
requests that are sent from the device. In order to forward these requests to
the engine, a helper address needs to be configured on the router interface
of the network of the host. A helper address takes the broadcast packet and
makes it a directed broadcast to the address specified.

Step 1: Connect to the console of the default router for the endpoint.

Step 2: Atthe CLI, enter the following commands.

Router#ena

Router#conf terminal

Router (config) #interface [interface]

Router (config-if) #ip helper-address 10.4.48.41
Router (config-if) #ip helper-address 10.4.48.42
Router (config-if) #exit

Router (config) #exit

Router#copy running-config startup-config
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Enabling Visibility to the Wireless Network

1. Configure 802.1X for wireless endpoints
Disable EAP-TLS on Cisco ISE

Add ISE as RADIUS Authentication Server
Disable the original RADIUS server

Add ISE as RADIUS accounting server
Add secondary DHCP server on WLC

o o s ® N

To authenticate wireless clients, you need to configure the wireless LAN
controllers (WLC) to use the new Cisco ISE servers as RADIUS servers for
authentication and accounting. The existing entry is disabled so that if there
are any issues after moving to Cisco ISE, you can quickly restore the original
configuration. Additionally, you configure the WLCs with Cisco ISE as a
secondary DHCP server so that profiling information can be obtained from
the DHCP requests from these clients.

Configure 802.1X for wireless endpoints

To differentiate wireless users in the authentication logs, create a rule to
identify when wireless users authenticate.

Step 1: Navigate to the Authentication Policy tab, mouse over Policy, and
then, from the menu, choose Authentication.

Step 2: Click the Actions button for the Default Rule, and then choose
Insert new row above. A new rule, Standard Policy 1, is created.

Step 3: Rename Standard Rule 1 to Wireless-Dot1X. Click the + symbol

in the Condition(s) box, and then choose Select Existing Condition from
Library.
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Step 4: In the Select Condition pull-down list, click the > symbol next to
Compound Condition.

Dictionaries

7 sl s Logour Fesdbak
Er=E v ©0 Task Mavigator ~ €}

—_— () Simpie Condition B
|2) Authentication | [8) Authorization [ ¢ Profiing [ Posture roup Access ¢ Policy Elements
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Define the Authentication Policy by selecting the protocals that ISE should use 1o 4 °H the identity sources that it should use for authentication,
Policy Type O Simple @ Rule-Based

T | 11 [ wired_tag Fadlt Metw@ | ad.. ) & Actions ~
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~  [wielessDotix 1 [ Condiion(s) = 5 ©] and. ) & actions -

. a| B add al conditions

Defauit Rule (If no match)

Condition Name

Select Condition [0 |} G

Step 5: Choose Wireless_802.1X, and then click anywhere to continue.

Compound Condition
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W Switch_Local Web_Athentication
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Policy Type () Simple (8 Rule-Based
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Default Rule (If no match)

Condition Mame

select Conditon © @,

Step 6: Click the Select Network Access pull-down list, click the > symbol
next to Allowed Protocols, and then select Default Network Access.

CISCO  Identity Services Engine sl admin  Logout Feedback

6 Task Navigator = €3

|2) suthentication | [@] Authorization  [4) Profiing [ Postre [ Client Provisioning  [) Security Group Access g, Palicy Elements.

Authentication Policy a

Define the Authentication Policy by selecting the protocols that 1SE shoLld Use to commurnicate with the network devices, and the identity sorces that it should use for authentication.
Policy Type O Simple @ Rule-Based
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Default Rule (If ne match) + allow protocols [ Alowed Protocdl : Default Netwd® | and use identity source EE—) ctions ~
<« = 8.
® Default Network Access
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Step 7: Click the black triangle to the right of the and... on the Wireless-
Doti1X rule. This displays the identity store used for this rule.

Step 8: Click the + symbol next to Set Identity Source.

Step 9: In the Identity Source drop-down list, choose the previously defined
AD server, for example. AD1.

Step 10: Use the default options for this identity source, continue by click-
ing anywhere in the window, and then click Save.

atlialn
€IS€0  Identity Services Engine

isel admin Logout Feschack

E 00 Tack Navigator ~ €))
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If authentication faled [Reect | ] =i
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If process faled

HEa - 17 wired_| Note: For authentications using PEAP, LEAP, EAP-FAST or RADIUS MSCHAP & actions ~
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Authentication Policy
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policy Type O Simple @ Rule-Based
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Disable EAP-TLS on Cisco ISE

For wireless deployments that aren't currently using digital certificates, you
need to disable EAP-TLS to allow clients to log in. You will be deploying
digital certificates in a later phase of this deployment.

Step 1: On the menu bar, mouse over Policy, and then, from the Policy
Elements section of the menu, choose Results.

Step 2: In the left pane, double-click Authentication. This expands the
options.

Step 3: Double-click Allowed Protocols, and then select Default Network
Access.
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Step 4: Clear the global Allow EAP-TLS check box and, under the PEAP
settings, clear the Allow EAP-TLS check box, and then click Save.

alialn
€ISCO  Identity Services Engine

A Home ns v  Policy v

Administration v

isel  admin  Logout  Feedback

o0 Task Navigator + €3

Allow EAP-GTC

Aliow Password Change Retries [1 ] (valid Range 010 3

] Allow EAP-TLS
- Allow EAP-FAST

EAP-FAST Inner Methods
Allow EAP-MS-CHAPY2

Allow Password Change Refries| 3 | (Valid Rangs 110 3)

Allow EAP-GTC

Allow Password Change Retries|[ 3 | (Valid Range 1103)

|2) Authentication  [9] Authorization 4] Profling @) Pesture  [&) ClientProvisioning |5 Security Group Access | & Policy Elements
Dictionaries  Conditions  [TResulls
( [0 Detect PAP as Host Loaku P
Results ’ A
[0 Allow CHAP
( »]
€=z ) O alow Ms-CHAPYI
M .
= [ Allow MS-CHAP2
A Authentication
= - Allow EAP-MDS
v [ Allowed Protocols
£ Default Network Acoess ] Detect EAP-MDS as Host Lookup
» At i
g oo ] AlowEAP-TLS
3 Prafiling
N [0 miow LEAP
» [ Posture 2
7] Allow PEAP
» [ Cllent Pravisioning -
» [ Security Group Access PEAP Inner Methods
- Allow EAP-ME-CHARYZ
[ Allow Password Change Rsmss (valid Range 0to 3)
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Add ISE as RADIUS Authentication Server

Perform this procedure for every wireless LAN controller (WLC) in the
architecture with the exception of the guest WLC in the demilitarized zone

(DMZ).

Step 1: Navigate to the WLC console by browsing to https://wlc1.cisco.local.

Step 2: On the menu bar, click Security.

Step 3: In the left pane, under the RADIUS section, click Authentication.

Step 4: Click New. A new server is added.

Step 5: Enter 10.4.48.41 for the IP address of the new server and your
RADIUS shared secret.

Step 6: Next to Management, clear the Enable box, and then click Apply.

cisco
Security

v AAR
General
» RADIUS
Authentication
Accounting
Fallback
» TACACS+
LDAP
Logal Hat Users
MAC Filtering
Disabled Clients
User Login Policies
AP Palicies

» Local EaP

} Priority Order

b Certificate

» Access Control Lists

Wireless Protection
Policies

» Web Auth
¥ Advanced

MONITOR

RADIUS Authentication Servers > New

Server Index (Prierity)
Server IF Address
Shared Secret Format
Shared Secret
Confirm Shared Seeret
Key Wrap

Port Number

Server Status

Support far RFC 3576
Server Timeout
Hetwark User
Management

PSec

ITROLLER

WIRELES:

< Back Apply
2 -
1044841
ASCIL v
ssssssses
ssssssses

[T] (Designed for FIPS custorners and requires a key wrap comnpliant RADIUS server)
1812
Enabled «
Enabled ~
2 seconds
Enable
[] Enable
] Enable

Step 7: Repeat Steps 4 through 6 to add the secondary engine, 10.4.48.42,

to the WLC configuration.
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Disable the original RADIUS server

After adding Cisco ISE as a RADIUS server, disable the current RADIUS
server in use. By disabling the server instead of deleting it, you can eas-
ily switch back if needed. Perform this procedure for every wireless LAN
controller (WLC) in the architecture with the exception of the guest WLC in
the DMZ.

Step 1: On the RADIUS Authentication Servers screen, click the Server
Index of the original RADIUS server, and then, for Server Status, select
Disabled. Click Apply.

Step 2: On the RADIUS Authentication Servers screen, click Apply.

figuration  Ping  Logout Refresh
K g e RaRaE e
cisco
Security RADIUS Authentication Servers Apply New...
~ RAR P
General Call Station ID Type £ IP Address -
w RADIUS
Authentication Use AES Key Wrap [ (pecigned for FIPS customers and requires a key nrap compliant RADIUS server)
Accounting
Fallback MAC Delimiter Hyphen -
» TACACSH
LB Network server
Local Met Users User Management Index Server Address Port IPSec Admin Status
MAC Filtering
Disabled Clients o 1 1044815 1512 Disabled Disabled -]
User Login Policies ] 2 1044841 1812 Disabled Enabled -]
AF Policies
] 3 1044842 1812 Disabled Enabled -]
» Local EAP

» Priority Order
b Certificate

b Access Control Lists 1. Calf Station ID Type will be appiicatie oniy for non 802.Xx authentication oniy.

Wireless Protection
Policies

» Web Auth

b Advanced

Step 4: Enter 10.4.48.41 for the IP address of the new server and your

RADIUS shared secret, and then click Apply.

cisco

MONITOR

Security RADIUS Accounting Servers > New __«Back | Apply
~ L Server Index (Priarity) 2 -
General
» RADIUS Server IP Address 1044841
Authentication
P Shared Secret Format ASCIT +
Fallback Shared Secret  esesssess
» TACACSH
LDAP Confirm Shared Seeret ssssssses
Local Met Users
MAC Filtering Port Nurmber 1813
Disabled Clients. Server Status Enabled =
User Login Policies
AP Palicies Server Timeout 2 seconds
b Local EAP Netwark User Enable
» Priority Order PSec [ Enable
b Certificate
» Access Control Lists
wWireless Protection
Policies
» Web Auth
» Advanced

Add ISE as RADIUS accounting server

Perform this procedure for every wireless LAN controller (WLC) in the
architecture, with the exception of the guest WLC in the DMZ.

Step 1: On the menu bar, click Security.
Step 2: In the left pane, under the RADIUS section, click Accounting.

Step 3: Click New. This adds a new server.
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Step 5: Repeat Step 4 to add the secondary engine, 10.4.48.42, to the WLC
configuration.

Step 6: On the RADIUS Accounting Servers screen, click the Server Index
of the original RADIUS server, and then, for Server Status, select Disabled.
Click Apply.

Step 7: On the RADIUS Accounting Servers screen, click Apply.

Hmin
cisco MONITOR CONTROLLER ~ WIRELESS ~ SECURITY M MEM COM HELP  EEEDBACK
Security RADIUS Accounting Servers Apply New...
~ AAA
eneral MAC Delimiter  Hyphen -
~ RADIUS
Authentication Network Server Admin
Accounting User Index Server Address  Port IPSec Status
Fallback
El 1 10.4.48.15 1813 Disabled Disabled
» TACACS+ 1 isable isable a
LOAP 2 10.4.48.41 1813 Disabled Enabled [~ ]
Local Met Users a 10.4.48.42 1813 Disahled Enabled [~]
MAC Filtering

Disabled Clients
User Login Policies
AF Policies

» Local EAP

» Priority Order

b Certificate

b Access Control Lists

Wireless Protection
Policies

» Web Auth
b Advanced
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Step 3: When the warning appears with a message about the WLANs need-
Procedure 6 Add secondary DHCP server on WLC ing to be disabled, click OK.

You need to add a secondary DHCP server to the WLC configuration in Interfaces > Edit < Back | apply |
order to send DHCP requests to the engine for endpoint profiling.

Step 1: Onthe WLC, navigate to Controller > Interfaces. Select the inter-
face for the clients you wish to monitor. General Information

Step 2: In the DHCP Information section, add the Cisco ISE server as the Interface Name wireless-data

Secondary DHCP Server, and then click Apply. MAC Address 88:43:e1:7e:08: af

Configuration

Guest Lan r

Quarantine -

Quarantineg Wlan Id II:I

Physical Information

The interface is attached to a LAG.

Enable Dynamic AP r
Managerment

Interface Address

WLAN Identifier 116

IF Address 104165
Netrnask |255.255.252.0
Gateway 104161

DHCP Information

Primary DHCP Server |1IZI.4.48.1D

Secondary DHCP Server |1I:I.4.48.41

Access Control List

acCL Mame Inune vl

HMote: Changing the Interface parameters causes the Widns to be
termnporatily disabled and thus may result in foss of connectividty for
some ciients,

Step 4: Click Save Configuration, and then click OK.
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The network infrastructure is now enabled for monitoring the network to
determine what types of devices are connecting. Additionally, authentica-
tion using ISE was enabled for the wireless network. This is a good place in
the deployment to test the deployment and monitor network access. Some
organizations may not need to implement the next phase and choose to
stop here.

Deploying digital certificates

1.

Install certificate authority

Install trusted root certificate for domain
Install trusted root on AD server
Request a certificate for ISE from the CA
Download CA root certificate

Issue certificate for ISE

Install trusted root certificate in ISE

Install local certificate in ISE

© © N o o &~ W N

Delete old certificate and request

In the next phase of deployment, you configure the infrastructure to support
the use of digital certificates for user and machine authentication. Using
digital certificates when deploying 802.1X is a Cisco best practice. In this
example deployment, you will be deploying digital certificates to Microsoft
Windows XP and Windows 7 endpoints as well as to Apple Mac OS X
devices. The certificate authority (CA) you will be using is the one built into
Windows Server 2008 Enterprise and you will enable it on the existing Active
Directory (AD) server.
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Install certificate authority

Step 1: Install an enterprise root certificate authority on the AD server.

Microsoft Windows Server 2008 Active Directory Certificate
Services Step-by-Step Guide:

http://technet.microsoft.com/en-us/library/cc772393%28WS.10%29.
aspx

Install trusted root certificate for domain

Install a trusted root certificate on the AD controller to distribute it to the
clients so that certificates from the CA server will be trusted.

Step 1: On the CA console, launch a web browser, and then connect to the
certificate authority, https://ca.cisco.local/certsrv.

Step 2: Click Download a CA certificate, certificate chain, or CRL.

Step 3: Make sure the current certificate is selected and the DER encoding
method is selected.

Deployment Details
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Step 4: Click Download CA Certificate, and then save the certificate file on

the AD controller.

Microsoft Active Directory Certificate Services — cisco-AD-CA

Download a CA Certificate, Certificate Chain, or CRL

To trust certificates issued from this certification authority, install this CA certificate chain.

To download a CA certificate, certificate chain, or CRL, select the cerfificate and encoding method.

CA certificate:

Encoding method:

& DER

 Base 64
Download CA cerificate
Download CA cerificate chain
Download latest base CRL
Download latest delta CRL

Step 7: Right-click Default Domain Policy, and then choose Edit.

E Group Policy Management

|2 Microsoft Exchange Security Grou | The following sites, domains, and OUs are linked to this GPO

=101 x|
(2 File  Action View Window Help |4|i|5|‘
L A ol N A 7 D |
& Group Policy Management Default Domain Policy
Bl 4} Forest: dsco.local Seo ;
B & poram pe | Details | Settings | Delegation |
=l 3 disco.docal Links
] Default Domain Policy Display lirks in this location: i >
(2] Domain Contrallers Jescolecd =

=1 [ Group Plcy Objects = [ Enforced [ Link Enabled [ Path
_EJ Default Domain Controllers Po ﬁ Yes

= cisco local No
&

T—— cisca local
=/ Sippicent Con E LA
(5 WMI Filters GPO Status » .
} L] Starter GPOs Back Up... |
‘?izm Polcy Model Restore from Backup...  [ening
5% Group Policy Modeling
7, Group Policy Results Import Settings... this GPO can only apply to the following groups, users, and computers:
Save Report... I
View y pated Users
New Window from Here  [ompLters (CISCO\Domain Computers)
Copy
e~ i Remve | Fupeies |
Rename
Refresh
[ ]
Help pked to the following WM fiter:
| [<rone> = Open
ll | Bl
|open the GPO editor

Step 5: On the CA console, navigate to Start > Administrative Tools >

Group Policy Management.

Step 6: Expand the Forest, Domain, local domain, and Group Policy
Objects.
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Step 8: Navigate to Computer Configuration > Policies > Windows
Settings > Security Settings > Public Key Policies, right-click Trusted
Root Certification Authorities, and then choose Import. The Certificate
Import Wizard launches.

B Group Policy Management Editor =10l x|

File Action View Help

N EIEEE S

= &l Computer Configuration ;I Issued To = | Issued By
= [ Policies
"] Software Settings
= || Windows Settings
(| Name Resolution Policy
= Scripts (Startup/Shutdown)
= g ecurity Settings
5 Account Polices
Local Policies
EventLog
7 Restricted Groups
4 System Services

| Ex

There are no items to show in this view.

75 wired Network (IEEE 802. 3) Policies
-] Windows Firewall with Advanced Security
] Network List Manager Policies

;‘j Wireless Metwork (IEEE 802. 11) Palides

[= || Public Key Palides
"] Encrypting File System
[ BitLocker Drive Encryption
] Automatic Certificate Request Settings
[Ba Trusted Root Certification Authorities
"] Enterprise Trust Import...
[ Intermediate Certification Authorites —
] Trusted Publishers sEE
7] Untrusted Certificates
|1 Trusted People

Al _ . —— Refresh

—
Export List... —’I

View *

‘Add a certificate to a store —_— | |

I e

Step 9: Click Next.
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Step 10: Click Browse, locate the trusted root certificate saved in Step 4,
and then click Next.

Certificate Import Wizard x|
File to Import
Specify the file you want to import.

File name:
C:\Downloads\certnew. cer

Browse... I

Maote: More than one certificate can be stored in a single file in the following formats:

Personal Information Exchange- PKCS #12 (.PFX,.P12)

Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P7B)
Microsoft Serialized Certificate Store ((55T)

Learn more about certificate file formats

< Back Mext = Cancel

Step 11: Place the certificate in the Trusted Root Certification Authorities
certificate store, and then click Next.

Step 12: Click Finish. The certificate imports.

Step 13: Click OK.

Deployment Details



In addition to installing the trusted root certificate on the AD server to be
distributed to workstations, you need to install it on the AD server directly. A
GPO update takes care of this automatically. In this procedure, you will force
the update to run immediately.

Step 1: On the AD console, navigate to Start > Run.
Step 2: Type cmd, and then press Enter to open a command window.

Step 3: Type gpupdate. The group policy updates.

Mi ft Windows [Uersion 6.1.76811
Copyright <{c> 2887 Microsoft Corporation. All rights reserved.

C-sUserssAdministrator BEA>gpupdate
Updating Policy...

Uzser Policy update has completed successfully.
Computer Policy update has completed successfully.

C:\Users“Administrator.BBB>

In order to obtain a certificate from the CA, Cisco ISE needs to generate a
signing request that will be used by the CA to generate a certificate.

Step 1: Connect to https://ise-1.cisco.local.

Step 2: Mouse over Administration, and then, from the System section of
the menu, choose Certificates.

Step 3: Under Certificate Operations, select Local Certificates.

Step 4: Click Add, and then choose Generate Certificate Signing
Request.

CISCO  Identity Services Engine sl admin  Logout  Feechack

A Home administration ¥

: o Task Navigator + €3

of Systen | L% Identity Management [ Network Resources 14 Guest Management
Deployment  Licensing ([ Certiiates | Looghg  Maitemsnce  Admin Access  Seftigs

- - Local Certificates
Certificate Operations

@ Local Certficates
@ Certificate Sigring Requests Pedt dpadd] | @esport xDE‘E"’
@ Certiicate Authorty Certificates [/ Friend [mport Local Server Certificate
85 5P Services [ Doy CENEr3tE SolfSigned Cartifcate HTTPSESP  ise-d.cisco local se-Lescoocal Fr, 21
Generate Certificate Sigring Request
Bind CA Certificate

Satecteds [Tt 1 B G L

B —

+  Protocol Issued To Issued By Walicl Fr

Step 5: Enter the fully qualified domain name (FQDN) of the Cisco ISE
server in the Certificate Subject field after the “CN=", and then click Submit.

€IS€o  Identity Services Engine ise-1 admin Logout Feechack

0 Task Navigator ~ €3

7 System Identity Management B Network Resources |24 Guest Management

Deployment Licensing Certificates Logging Maintenance Admin Access Settings

Local Certficates = Generate Certificate Signing Request

Certificate Dperation, Generate Certificate Signing Request

© Local Certficates

@ Certificate Signing Requests Certificate

1@ Certficate Authority Certificates * Certificate Subect | Ch=pe-1.cscolocal

#9 OSP Services * Key Length 2048 -
* Digest to Sign wWith [ SHA-256 hd

Step 6: Click OK. This acknowledges the certificate was generated
successfully.

Step 7: Click Certificate Signing Requests, select the check box next to
the new request, and then click Export.

[0
ISCO  I[dentity Services Engine ise-l admin Logout Feedback

: o Task Navigator + €3

% System Identity Management B Network Resources [ Guest Management

Deployment  Licensing [ Certificates | logging  Maintensnce  Admin Access  Settings
Certificate Signing Requests
Certificate Operations gning Req

Setected 1 [ Totut 1 B 4G
@ Local Certficates

@ Certificate Sigring Requests @Export | K pelete oW | <8
@ Cortficate Authorky Certficates O Friendly Name + | Certificate Subject Key Length Tmestamp
@ OCSF Services ise-1.cisco.docal Chi=se-1.ciscolocal 2048 Thu Mar 08 13:16:35 PST

Step 8: Save the file to your local machine. You will use this file to generate
a certificate on the CA for Cisco ISE.




Download CA root certificate

Step 1: Browse to https://ca.cisco.local/certsrv.
Step 2: Click Download a CA certificate, certificate chain, or CRL.

Step 3: Make sure the current certificate is selected and the DER encoding
method is selected.

Step 4: Click Download CA Certificate, and then save the certificate file on
the local machine.

Microsodt Active Direc

Download a CA Certificate, Certificate Chain, or CRL

To trust certificates issued from this certification authority, install this CA cerificate
To download a CA certificate, certificate chain, or CRL, select the certificate and encoding method

CA certificate:

=
Encoding method:
& DER
" Base 64

Install CA certificate
Download CA certificate
Dovnload CA cerfificate chain
Download latest base CRL
Download latest delta CRL
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Issue certificate for ISE

Step 1: Click Home. The CA's home screen displays.

Step 2: Click Request a certificate.

Step 3: Click advanced certificate request.

Step 4: Open the certificate file saved in Procedure 4, “Request a certifi-
cate for ISE from the CA" in a text editor, such as Notepad. Select all the text

and copy it to the clipboard.

Step 5: Paste the contents into the text box in the Saved Request section of
the certificate request that is open in the browser.

Step 6: From the Certificate Template drop-down list, choose Web Server,
and then click Submit.

Microsoft

Submit a Certificate Request or Renewal Request

To submit a saved request to the CA, paste a base-64-encoded CMC or PKCS #10 certificate request or PKCS #7 renewal request generated
by an external source {such as a Web server) in the Saved Request box

Saved Request:

[untfohivsCtonVt pHeTZnlysGiEnRySECIudYB 62 -]
Bage-B4-encoded [LbP/ xwsEiIX4pLoSXeL3 12 D¥bbuze0ZXohodirfn
certificate request [CDUKF V2 wolluFks3cOr ZQRIBERPHYS rpgCOUARE R

(CMC ar ROvi3q4XMGW/ eF 12/ U0LITF 3 jubn/ HitveIGH1KDOD

PKCS #10 or [EHg 13BGNaXtnB4fHhEuSHI 15t sE0whhCdi6i42Qf

PKCS#):  |-———- END CERTIFICATE REQUEST---—- -
K ol

Certificate Template:
| ‘Weh Server j

Additional Attributes:

Attributes

Subrmit>

Step 7: Select DER encoded, and then click Download certificate. The
certificate saves to your local machine.
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Procedure 7 Install trusted root certificate in ISE

Step 1: Inthe Cisco ISE interface, mouse over Administration, and then,
from the System section of the menu, choose Certificates.

Step 2: Click Certificate Authority Certificates, and then click Import.

aluli
CISCO  Identity Services Engine

Ise-l  admin  Logout  Fesdback

0 Task Navigatar + €3

ofe System | &1 Icenfity Management BB Metwork Resources [ Guest Management

ey
Deplyment  Licensing [ Certicates | Logging  Maiterance  Admin Arcess  Settings

f . N Certificate Authority Gertificates
Certificate Dperations

@ Local Certficates

setesess [ Towsiz B G o
g D

Issued By

Fedt ofempot | @vExport | MDelete

[ Friendly Name | Issled To

@ Certificate Sigring Requests
@ Certfficate Authority Certficates walid From Ex|
Fii, 2 Mar 2012 Sa

Fri, 2 Mar 2012 Sa

O se-Lcisco.docal#e- 1.oscoocal# 00001
O ise-2.ciscalocal#ise-2.cisco. local#00002

G OCSP Services ise-1.cisconlocal ise-1,cisco.local

ise-2.cisco.local Ise-2,cisco local

Step 3: Click Browse, and then locate the root CA certificate saved in
Procedure 5, “Download CA root certificate.”

Step 4: Select Trust for client authentication, and then click Submit.

Identity Services Engine sl admin  Logout  Feedback

- Task Navigator

ofe Systern | &L Identity Management  [E Metwork Resources (8] Guest Management

Deployment  Licensing (" Certificates | Looging  Maintenance  Admin Access  Settings

Carthcste Atherky Certcates > Tmport
Import a new Trusted CA (Certificate Authority) Certificate

Browse.

p
Certificate Operations
@ Local Certficates

@ Certificate Signing Requests * Certificate Fie [CADownloadsironteer.cer

@ Certificate Authority Certificates
1@ OCSP Services

Friendly Mame [

Al Certificate Authority Certificates are avalable for selection s the Root CA for secre LDAR connections. In addition, they may be enabled
r EAR-TLS and administrative authentication below:

Trust for client authentication

[0 Enable Valdation of Certificate Extensions (accept only vald certificate)

Descrigtion |

E==8
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Procedure 8

Install local certificate in ISE

Step 1: Inthe Cisco ISE interface, mouse over Administration, and then,
from the System section of the menu, choose Certificates.

Step 2: Click Local Certificates.

Step 3: Click Add, and then choose Bind CA Certificate.

aluli
CISCO  Identity Services Engine

e
o System | & Icentity Management

Ise-l  admin  Logout  Fesdback

f 0 Task Navigatar ~ €3

Network Resources [ Guest Management

e
Deplyrment  Licensing [ Certiicates

Logging  Mairtenance

( Certificate Operations
© Local Certificates
& Certficate Signing Requests
@ Certficate Authority Certificates
@ OCSP Servicss

Admin Arcess  Settings

Local Gertificates

Selected 0 | Total 1 @ 5
g D

Issued By Vald Fr

"‘ Edit %Add @Exwt xDe\ele
] Friend meort Local Server Certificate
[ Dy Generate Self Sioned Certicate
Gererate Certificate Sigring Request
Bind CA Certificate

~  Pratocal
HTTPS,EAP

Issued Ta

ise-1,ciscodocal ise-Locisco.local Fri, 21

Step 4: Click Browse and locate the certificate saved from Step 1, “Issue

certificate for ISE.”

Step 5: In the Protocol section, select both the EAP and Management
Interface check boxes. When you receive a warning that checking the
Management Interface box will require the Cisco ISE appliance to restart,
click OK, and then click Submit.

alialn
€IS€O  Identity Services Engine

—_———
=% System | &2 Identity Management

B Network Resources

ise-1 admin  Logout Feedback

ask Mavigatar 2

[ Guest Management

r——
Deployment  Licensing | Certificates

Logging  Maintenance:

( Certificate Operations
@ Locel Certificates
@ Certficate Signing Requests
@ Certficate Authority Certficates
@ OCSP Services

Taeas

admin Access Settings

Local Carlifcates > Bind CA Signed Certificate
Bind CA Signed Certificate

Certificate

* Certificate Fle [CADownloads\ISEcertcer

Browse..

Friendly Name: [

[] Enable validation of Certificate Extensions (accept only vaiid certificate)

Protocol

EAP: Use certificate for EAP protocols that use SSLYTLS tunneling
Management Interface: Use certificats to authenticats the web server (GUI)

Override Policy

& cartificate being imported may be determined to akeady exist in the system when it has ither the same Subject or
Issuer and serial number a an existing certificate, In such a case, selection of the "Replace Certificate” ontion wil diow the
certfficate contents to be replaced whie retaning the existing protocel selections for the certificate.

[ Replace
Certificate

| Cancel |

Step 6: When you receive a warning that the Cisco ISE appliance will

restart, click OK.
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Delete old certificate and request

Now that you have imported the local certificate into Cisco ISE, you need
to delete the old self-signed certificate as well as the certificate signing
request generated previously.

Step 1: Inthe Cisco ISE interface, mouse over Administration, and then, in
the System section, choose Certificates.

Step 2: Click Local Certificates.
Step 3: Select the box next to the self-signed certificate. This is the certifi-

cate issued by the Cisco ISE appliance and not the certificate issued by the
CA that was just imported.

aluli
CISCO  Identity Services Engine

Ise-l  admin  Logout  Fesdback

Adrriristration v © Task Navigatar - €3

I Identity Management [ Metwork Resources [28) Guest Management

———
o System

e
Deplyment  Licensing [ Certicates | Logging  Maiterance  Admin Arcess  Settings

f B - Local Certificates
Certificate Operations

Selected 1 | Total2 & 5 o
@ Local Certficates

o oo o st e dass | oo | Xode E C —
@ Certficate Authority Certificates [ Friendly Mare | pratocol Issued To Issued By Vald Fr
@ OC5P Services Defaut selfsigned server certificate ise-1.ciscodocal se-L.cisco.docal Fri, 21
i ise-1.clsco.lncal#cisco-AD- 3 ise-1,cisco Joca cisco-AD- u,
O ise-1.cisco.local#cisco-AD-CA#00001 HTTPS,EAP 1.cisco.local AD-CA Thu, &

Step 4: Click Delete, and then click OK.
Step 5: Click Certificate Signing Requests.

Step 6: Select the box next to the certificate signing request that was cre-
ated in Procedure 4, “Request a certificate for ISE from the CA.”

Enable 802.1X authentication

1. Create ISE policies
2. Enable certificates
3. Enable EAP-TLS

You will configure ISE policies to support 802.1X authentication using digital
certificates for both wired and wireless users.

Create ISE policies

An authentication profile is used to determine how a certificate will be used
for authentication.

Step 1: In Cisco ISE, mouse over Administration, and then, in the Identity
Management section, choose External Identity Sources.

Step 2: In the left pane, click Certificate Authentication Profile, and then
click Add.

sl
€ISE0  Identity Services Engine sl admin Logout Feschack

E o0 Task Navigator ~ €

%o System £ Identity Management B network Resources |24 Guest Management

€IS€o  Identity Services Engine ise-l  admin  Logout  Feedback

E 0 Task Navigator = €3

ns ¥ Policy v Administration ¥

ofs Systemn | OR Identity Management [ Metwork Resources [ Guest Management

——
Deployment  Licensing [ Certificates | Looging  Maintenance  Admin Access  Settings

f Certificate Signing Requests
Certificate Operations 'gning Req

selected 1| Toat1 B G L
@ Local Certificates

@ Cenficate sgring Requests @rexport | Koekete how [ |9
@ Certficate Authority Certificates [ Friendly Name - | Certificate Subject Key Length Timestamp
@ OC5P Services ise-1.dscodocal CN=ise-1.cisco.local 2048 Thu Mar 02 13:16:35 PST

FETT———
Identities Groups External Identity Sources Identity Source Sequences Settings

f Certificate Authentication Profile
External Identity Sources

¢ =E .

[ Certificate Authentication Prafile 5

selected 0 | Totato G

D —

Fedt dpadd  Qyouwlicate | Xoelete

O Name | Description

“4 Active Directory Mo data available

[ oar 3
(] RADIUS Teken 3
(] RSA SecurID B

Step 7: Click Delete, and then click OK.
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Step 3: Give the profile a meaningful name, and then, from the Principal
Username X509 Attribute drop-down list, choose Subject Alternative
Name.

oo
CISCO  Identity Services Engine sl admin Logout Feedback

f o Task avigator ~ €3

f Home Cperatins ¥ Poicy v Administration v

of System | LU Idenfity Management | [ Network Resources 14 Guest Management

TExternal ldentitr Sources
Identites  Groups [ Externd Identity Sourees | Identity Source Sequences  Settings

Carlificate Authentication Profilss Lit > New Certificate Authentication Profile

-
External rentity Sources Certificate Authentication Profile

*‘ CE @' * Name

[ Centficate Authentication Profile o
‘g' Active Directory Description

£ Lo 5

[ RADIUS Token 3

(] RSA Securln 5

Principal Usermartie XS09 ARMDUNE | o 4ot alremative Name .

[ Perform Binary Certificate Comparison with Certificate retrieved from LDAP or Active Directory

.
2 LDAP/AD Instance Name

: =

Step 4: Click Submit.

An identity source sequence allows certificates to be used as an identity
store and also allows for a backup identity store if a primary identity store is
unavailable.

Step 5: Click Identity Source Sequences, and then click Add.

alialn
€IS€CO  Identity Services Engine

A Home ns v

ise-1 admin  Logout  Feedback

Adrministration v E 00 Task Navigator ~ €

o% System | L1 Identity Management | [ Network Resources |4 Guest Management

T ——
Identities  Groups  External Identity Sources ([ Tdentity Source Sequences | Settings
Identity Source Sequence

Selected 0 | Total2 5

) E— |

Fede deadd  Gyoupicste | MDelzte
O Hame a  Description Identity Stores
O Guest_Portal_Sequence A built-in Tdentity Sequence for the Guest Portal Internal Users

O Sponsor_Portsl_Sequence A bilt-in Identity Sequence for the Sponsar Partl Internal Users

Step 6: Give the sequence a meaningful name.

Step 7: In the Certificate Based Authentication section, select Select
Certificate Authentication Profile, and then choose the profile created
previously.

Step 8: In the Authentication Search List section, double-click the AD
server from the Available list to move it to the Selected list.
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Step 9: In the Advanced Search List Settings section, select Treat as if the
user was not found and proceed to the next store in the sequence.

oo
CISCO  Identity Services Engine sl admin Logout Feedback

¢ oo TaskNavigator ~ €3

¢ System Identity Management B Netwark Resources [ Guest Management

Mdentiv Source Seauences |
Idenfiies  Groups  External dentity Sources [ Identity Source Sequences | Settings

Idanthy Source Sequancas List > New Identity Source Sequence -
Identity Source Sequence
v Identity Source Sequence

"Name | pot1x_Certificates

Deseription

¥ Certificate Based Authentication

Select Certificate Authentication Profile [DotLe_Certs
* authentication Search List

Aset ofidentity sources that will be accessed in sequence until first authentication succeeds

Awailable Selected
Internal Endpoints - D1 =

Internal Users

5l
=

HE HE

* Achvanced Search List Settings
Selectthe action to be performed if a selected identity store cannot be accessead for authentication

() Do notaccess other stores in the sequence and sst the attriute to " d =

(@ Treatas ifthe userwas not found and proceed to the next store in the sequence

Step 10: Click Submit.

Enable certificates

Now that you have created a certificate authentication profile and identity
source sequence for digital certificates, you need to enable the 802.1X
authentication policies for both wired and wireless users.

Step 1: Mouse over Policy, and then, from the drop-down menu, choose
Authentication.

Step 2: Click the black triangle to the right of the and... of the Wired-Dot1X
rule. This brings up the identity store used for this rule.

Step 3: Click the + symbol next to the AD1 identity store entry.
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Step 4: In the Identity Store drop-down list, choose the identity source
sequence created in Procedure 1, “Create ISE policies,” use the default

options for this identity source, and then click anywhere in the window to
continue.

mmm
CISCO  Identity Services Engine ise-l  admin  Logout  Feedback
f Home ¢ ns v Polcy v Adminstraton v

E oo Task Navigator + )

—_———
Authentication | [g] Authorization  [4) Profiing Posture Client Provisiaring Security Group Access % Policy Elements

Authentication Policy

Define the Authentication Poicy by selecting the protocols that ISE should use to communicate with the netwark devices, and the identity sources that it should use for authentication.
Policy Type O Simple  (® Rule-Based

- [me8 |+ 1F [ wired_mag <> | dlow protocol [ lowed Protocol : Defadlt Netwd | and.. ) i Actions v
- [Wired-Dot1x | ¢ IF [ wired_soz.4% <> | dlow protocols | Alowed Protocol : Default Netwds | andh..  « G actions
2 Default use [aD1 = O Actions -
Identity Source|Dot1X_Certificates )

Options

If authentication faled[Rejert | +

~ | wireless-Dot1x If | wirele If user not found[Reject | + | i Actions v
e If process failed
Default Rule (IF ho match) i allow prot

Actions ~
Mote: For authentications using PEAP, LEAP, EAP-FAST or RADIUS MSCHAP @7
it s not possible to continue processing when authentication fais or user i ot found.
If continue option is selected in these cases, requests wil be rejected

For wireless users, you should modify the authentication policy to first
check if the client is using EAP-TLS and then, if not, to allow them to use
an authentication method like PEAP that uses a user name and password
for credentials. This allows users who haven't gotten certificates yet to still
access the network. Once they connect to the network, Windows clients

will get their certificates pushed to them and other endpoints can manually
obtain a certificate.

Step 5: Click the black triangle to the right of the and... of the Wireless-
Doti1X rule. This brings up the identity store used for this rule.

February 2012 Series

Step 6: In the Actions drop-down list next to the Default rule, choose Insert
new rule above.

aluln
CIsc i rvices Engine

el advin Logout Feedback

29 Task Navigator ~ €3

euthentication | [@) Authorization |4 Profiing Fosture Client Provisioning Security Group Access &, Policy Elements

Authentication Policy

Define the Authetication Policy by sslecting the protocols that 1S shouid use to communicate with the network devices, and the identity sources that it should use for authentication
Poicy Type O Simple @ Rule-Based

- | [mag ] :1f [ wired_mag &) allow protacols [Alowed Protocel : Defauit Netwd | and... & Actions ~
[(wired-Dotix ] ¢1f [wired_s0z.1x <] dllow protacols [alowed Protocol: Defaut Netwe | and.. ) & actions -+
[‘wireless Datix ] :1f [ wireless_g02.1x | alow protocchs [allowed Protocel : Default Netwd® | and... & actiors ~

Defalt i use [aD1 > % actions -

< Insert new row above |

Defait Rule (If na match) allow protocols | allowed Protocol : Default Netwis | and use identity source [ ntemal Users L i actions -

Step 7: Give the rule a name, and then open the expression builder by
clicking the symbol next to the Enter Condition box.

Step 8: Click Create New Condition (Advance Option).

Step 9: In the Expression drop-down list, click the arrow next to Select
Attribute.

Step 10: Click the arrow next to Network Access, and then select
EapAuthentication.

Network Access

u A rivethad
0 Device 1P Address
0 Esphuthentication

Expression Builder

B 4dd &l Conditions Below to Library

Condition Name Expression ———
[ Select Attrbute O | | ] &

[ ==
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Step 11: In the second drop-down list, choose Equals, and in the last drop-
down list, choose EAP-TLS, and then click OK.

Expression Builder

. Add All Conditions Below to Library

Condition Name Expression
0 Network Access €370 | [Equs ] [EapTis <] &,

[oc Ja==n)

Step 12: Click the + symbol next to Internal Users.

Step 13: In the Identity Store drop-down list, choose the identity source
sequence created in Procedure 1, “Create ISE policies,” use the default
options for this identity source, and then click anywhere in the window to
continue.

e s Logaut  Fesdback

A

T2 Astrentiaton ) [g] Authorcatin. [ ofing | [ Pastre (o] CienEProveonety (=) Sectniy GrliiAess (g, Poiey Eiments
Authentication Policy B
st t 152 shodduse to and for atrentcation
Poley Tyge | O S © s gised
g w sl proteecss [aowed rtocal Defadt etw | B _pctons -
< [Fimaomx ]t [ gizix %] aow protocas [ o [
5 " rap—— o o B i
8 &= I 1 o [amaren = T v
— [P —) & o] B
options
1F authentication faled[Reect [~ ]
Defat e G tfuser ot oundleet 7] T potors -
frocess tocorog =]
ot , Lens, EnprasT

Step 14: Click Save.
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In a previous section, you disabled EAP-TLS. Now that you are using digital
certificates, you need to re-enable it.

Step 1: On the menu bar, mouse over Policy, and then, in the Policy
Elements section, choose Results.

Step 2: In the left pane, double-click Authentication. This expands the
options.

Step 3: Double-click Allowed Protocols, and then choose Default Network
Access.

Step 4: Select the global Allow EAP-TLS check box and, under the PEAP
settings, select the Allow EAP-TLS check box, and then click Save.

€ISCO  [Identity Services Engine iss-1  admin  Logout  Feedback.

v Administration v F oo Task Navigator + €)

—_,—————
Authertication  [®) Authorization  [-5] Profiling Posture Client Provisioning Security Graup Access | &% Policy Elements

Dictionaries  Conditions [ Resufts

Results O Allow Ms-CHaPy1 |
Allow MS-CHAPYZ
( 2) -
&=z ) - Allow EAP-MDS
- [ Authentication [ Detect EAP-MDS as Host Lookup
v [ Mllowed Protocols Allow EAP-TLS
3 Defaul Network Acoess ) AowiEar

» ] Auathorization
- Allow PEAP

> [ Peafiting
» [ Posture PEAP Inner Methods
» [ Client Provisioning Allowe EAP-MS-CHAPZ

> [ Securty Graup A
9 Securty Graup Access Allow Password Changs Reties [ 1 | (valld Range 010 3)

Hlow EAP-GTE
9 Allow Password Change  Retries (valid Range 010 3)

1 Aliow EAP-TLE

- Allow EAP-FAST

EAP-FAST Inner Methods

Allow EAP-MS-CHAPYVE _
Allow Password Change Retries|[ 3 | (valid Range 110 3)

Hiow EAP-GTE
Allow Password Charge Remss (valid Range 1o 3)

@ usepacs O DontUse PACS

Tunnel PAC Tirme To Live [Das [ ~] -
« | Ll—l

€Y Help Alarms @ 0 4 0@ 2 | = Notifications (0)
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Configure Group Policy Objects

1. Create template for workstations
Create template for user auto-enrollment

Configure GPOs for wired endpoints

> WD

Configure GPOs for wireless endpoints

In this deployment you will be using Group Policy Objects (GPOs) to
distribute certificates and to configure the native 802.1X supplicant for
Windows XP and later endpoints that are members of the domain. Machine
certificates are distributed when the machine joins the domain and user
certificates are deployed to the endpoint where the user logs in to the
domain. The steps in this example deployment describe how to edit the
Default Domain Policy so that it will apply to all users but you could create a
new policy object and apply it to a subset of users if you prefer.

Create template for workstations

You need to create a certificate template on the CA to be used to distribute
machine certificates to workstations that join the Active Directory (AD)
domain.

Step 1: On the CA console, navigate to Start > Administrative Tools >
Certification Authority.
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Step 2: Expand the CA server, right-click Certificate Templates, and then
choose Manage. The Certificate Templates Console opens.

§8 certsrv - [Certification Authority (Local)\cisco-AD-CA\Certificate Templates] =10l x|
Ble Action View Help
5| o= H

g] Certification Authority (Local)
El g dsco-AD-CA
| Revoked Certificates

Name [ Intended Purpose |
5 Computer (2003 Tempiate) Server Authentication, Client Authentication
5 User Auto-enroliment Client Authentication, Sacure Email, Encry...
B Server Authentication

T cep enaryption Certificate Request Agent

3| Exchange Ervoliment Agent (Offine reg.., Certificate Request Agent

- ffine request) 1P security IKE intermediate

°| Issued Certificates
] Pending Requests

| Faled Requests

Bl Certificate Templatge

Iy Email Replication Directory Service Email Replication
Controller Authentication Client Authenti 1, Server Authenti
covery Agent File Recovery
Fs Encrypting File System
i Controller Client Authentication, Server Authentication
Exportst..  Rrver Server Authentication
T ber Client Authentication, Server Authentication
Enaypting File System, Secure Emai, Clien..,
T Subordinate Certification Authority <Al>
) Administrator Microsoft Trust List Signing, Encrypting Fie...

Starts Certificate Templates snapin [ [

Step 3: Right-click the Computer template, and then choose Duplicate
Template.

Step 4: For compatibility, make sure that Windows 2003 Server Enterprise
is selected.

Step 5: In the template properties window, click the General tab, and then
give the template a name.

Step 6: On the Request Handling tab, select Allow private key to be
exported, and then click CSPs.
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Step 7: Select Requests must use one of the following CSPs and
Microsoft Enhanced Cryptographic Provider v1.0, and then click OK.

Properties of Hew Template EI

_in.ﬂnmﬁ&qﬂn&rl:l&pﬂmd&dﬁnﬂﬂﬁ]&ﬁﬁlmslm
General Request Handing |  Subject Name | Server

Premnse- | Sinnat = and encnemtinn -|
CSP Selection x|

Choose which cryplographic service providers [C5Ps) can be used in
requests:

' Fequests can use any CSP available on the subject’s computer

¥ Requests must use one of the following CSPs:
C5Ps:

[ IMicroscft Base Smart Card Crypto Provider
[ |Microsoft DH SChannel Cryptographic Provider

I Microscft Enhanced Cryptographic Provider w1.0

[IMicrasoft Enhanced D55 and Difie-Hellman Cryptograpkes Provides
[ |Microsaft Enhanced RSA and AES Cryptographic Provider

[ IMicroscfi RSA SChannel Cryptographic Provider

[ IMicrosoft Strong Cryptographic Provider

{C5Ps) should be used. chck CS5Ps. e

oK Cancel | oply | Heb |
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Step 8: On the Security tab, click Domain Computers, and then make sure

Allow is selected for both Enroll and Autoenroll.

Properties of New Template EI

General | FRequestHanding | SubjectMame | Server |
lssuance Requirements ] Superseded Templates I Bdensions  Securty
Group or user names:
B2, futhenticated Lsers
A Administrator (Administrator@cisco local)
2 Domain Admine (C1500" Domain Adming)
&2, Domain Computers (CISCO"\Domain Computers)
82 Enterprise Admins (CISCO"\Enterprise Admins)

Pemissions for Domain Computers
Full Contral

Raad

Vrite

Enrall

Autoenrol

grooo|f
ooooo| g

For special pemissions or advanced seitings. chick Advanced |
Advanced.

oK [ Camced | My |  Her |

Step 9: Use the defaults for the remaining tabs, and then click OK.

Step 10: Close the Certificate Templates Console.
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Step 11: In the Certificate Authority console, right-click Certificate
Templates, and then choose New > Certificate Template to Issue.

r_h certsry - [Certification Authority (Local)\cisco-AD-CA]

File Action View Help

T YRR I

e Revoked Certificates
_ Revoked Certificates " Iesued Certificates
] Issued Certificates | Pending Requests
| Pending Requests ~ Failed Requests
'7 Failed Requests _ Certificate Templates

[Enable additional Certficate Templates on this Certification Authority
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Step 12: Choose the previously defined template, and then click OK.

[N Enable Certificate Templates

Select one Certificate Template to enable on this Cerification Authority.
Note:  a certfficate template that was recently created does not appear on this list, you may need to wait until
information about this template has been replicated to all domain controllers.

All of the certificate templates in the organization may not be available to your CA.
For more information, see Certificate Template Concepts.

Name |

Intended Purpose

& 8021 User
E Autherticated Session
E CA Exchange
E Code Signing

Computer (2003 Template)
@ Cross Certffication Authaority
E Enrollment Agent
E Enrollment Agent (Computer)
E Exchange Signature Only
iﬁll Exchanae User

Client Authentication, Secure Email, Encrypting File System
Client Authentication

Private Key Archival

Code Signing

Server Authentication, Client Authentication

<All>

Certificate Request Agent

Cerdificate Request Agent

Secure Email

Secure Email

o]

Cancel |

When machines join the domain or when the GPO policy is refreshed (the
default period is 90 minutes), the machine receives a machine certificate to
allow for 802.1X machine authentication.
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Create template for user auto-enroliment

This deployment uses Group Policy Objects (GPOs) to have domain users
auto-enroll to obtain a certificate when they log in to the domain. You need
to create a certificate template for these users to enable auto-enroliment.

Step 1: On the CA console, navigate to Start > Administrative Tools >
Certification Authority.

Step 2: Expand the CA server, right-click Certificate Templates, and then
choose Manage. The Certificate Templates Console opens.

B8 certsrv - [Certification Autharity (Local)\cisco-AD-CA\Certificate Templates] =101 x|
Ble Action View Help
e%7d> @

il Certification Authrity (Local) Name [ tntended Purpose [
El @i dsco-AD-CA 3| computer (2003 Template) Server Authentication, Client Authentication
1 Revoked Certificates 5 User Auto-enroliment Client Authentication, Secure Email, Encry...
| Issued Certificates B Server Authentication
[E] Pendng Requests H cer enaryotion Cartificate Request Agent
| Failed Requests ] Exchange Ervolment Agent (Offine req...  Certificate Request Agent
Syt - ffiine request) IP security IKE intermediate
Iry Email Replication Directory Service Email Replication
Controller Authentication Client Authentication, Server Authenticatio...
kovery Agent File Recovery
Fs Encrypting File System
L Controller Client Authentication, Server Authentication
Exportist..  Rever Server Authentication
T ber Client Authentication, Server Authentication
Enarypting File System, Secure Emai, Clien...
T Subordinate Certification Autharity <Al>
3 Administrator Microsoft Trust List Signing, Encrypting Fie...
Starts Certificate Templates snapin [ [

Step 3: Right-click the User template, and then choose Duplicate
Template.

Step 4: For compatibility with Windows XP, make sure that Windows 2003
Server Enterprise is selected.

Step 5: In the template properties window, click the General tab, and then
give the template a name.
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Step 6: On the Request Handling tab, select Allow private key to be
exported, make sure Enroll subject without requiring any user input is
selected, and then click CSPs.

Step 7: Select Requests must use one of the following CSPs and
Microsoft Enhanced Cryptographic Provider v1.0, and then click OK.

Step 8: On the Security tab, click Domain Users, and then make sure Allow
is selected for Read, Enroll, and Autoenroll.

Properties of New Template x|

General I Reguest Handling I Subject Name I Server |
lzsuance Reguirements | Superseded Templat&al Edensions  Securty

Emup Qr User names.

SR Authenticated Users

& Administrator {Administrator@cisco local)

E!_, Domain Admins (C1SCO%Domain Admins)

82 Domain Users {C1SCONDomain Users)

:;!_ Erterprise Admins (CISCO\Enterprse Admins)

Add.. | Remove |

Pemissions for Domain Users Allow Dery
Full Cortrol (M| O
Read O
Write O O
Enrall a
Sytoenroll O

For special pemissions or advanced settings., click
Advanced.

Advanced |

Leam about access control and pemissions

ok [ cance | mepy | Hen |
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Step 9: Use the defaults for the remaining tabs, and then click OK.
Step 10: Close the Certificate Templates Console.

Step 11: In the Certificate Authority console, right-click Certificate
Templates, and then choose New > Certificate Template to Issue.

EEJ certsrv - [Certification Authority (Local)\cisco-AD-CA\Certificate Templates]

=lol x|

File Action View Help

€2 X|d=H

iﬁ Certification Authority (Local) Name | Intended Purpose

=] 0:;1 cisco-AD-CA
71 Revoked Certificates
|| Issued Certificates
|| Pending Requests
| Failed Requests
=

| Computer (2003 Template) Server Authentication, Client Authentication
EI CEP Encryption Certificate Request Agent
| Exchange Enrollment Agent (Offine reg... Certificate Request Agent
5 tPsec {Offline request) IP security IKE intermediate
| Directory Email Replication Cirectory Service Email Replication
Domain Controller Authentication Client Authentication, Server Authenticatio...
= = File Recovery
Encrypting File System

Manage

View ¥ || Domain Controller Client Authentication, Server Authentication
Web Server Server Authentication
Refresh ) -
- Computer Client Authentication, Server Authentication
Export List... . .
| User Encrypting File System, Secure Email, Clien...
Help Subordinate Certification Authority <All>
B Administrator Microsoft Trust List Signing, Encrypting File...

Enable additional Certificate Templates on this Certification Authority

Step 12: Choose the previously defined template, and then click OK.

X Enable Certificate Templates

Select one Certificate Template to enable on this Certification Authority.

Note: I a certificate template that was recently created does not appear on this list, you may need to wait until

information about this template has been replicated to all domain controllers.
All of the cerdificate templates in the onganization may not be available to your CA.
For more information, see Cedificate Template Concepts.

MName | Intended Pumpose

E Router (Offline request) Client Authentication
E SBA QCSP Response Signing QCSP Signing
E Smartcard Logon Client Authentication. Smart Card Logon
E Smartcard User Secure Email, Client Authentication, Smart Card Logon
E Trust List Signing Microsoft Trust List Signing

Uzer Auto-enroliment
E User futoenrollment
E User Signature COnhy Secure Email, Client Authentication
& Warkstation Authertication Client Authentication

1

Client Authentication, Secure Email, Encrypting File System
Client Authentication, Secure Email, Encrypting File System

o]

Cancel |
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Users will have a certificate pushed to them the next time they log in to the
domain or after the GPO policy is refreshed. If the user logs in to multiple

endpoints, the certificate is deployed to each of them.
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Configure GPOs for wired endpoints

This deployment uses GPOs to configure the 802.1X supplicant on wired
endpoints running Windows XP SP3 and higher.

Step 1: On the CA console, navigate to Start > Administrative Tools >
Group Policy Management.

Step 2: Expand the Forest, Domain, local domain, and Group Policy
Objects.

Step 3: Right-click Default Domain Policy. The Group Policy Management
Editor opens.

Step 4: In the Group Policy Management Editor, navigate to Computer
Configuration > Policies > Windows Settings > Security Settings.

Step 5: Right-click Wired Network (IEEE 802.3e) Policies, and then
choose Create a New Wired Network Policy for Windows Vista and Later
Releases.

-loix]

File Acton \View Help

A EINEEN =

Fl ¢ Computer Configuration &| | Name | Description |
= [ Polices
# | Software Settings
5 1 Windows Settings
[ [ Mame Resclution Policy
=1 Scripts (Startup/Shutdown)
E 5 Security Settings
2} _ﬂ Account Policies
B g Local Polides
® [ Eventlog
B [ g Restricted Groups
=+
w
W

There are no items to show in this view.

g System Services
o Registry
4 File System

r Windows Vista and Later Releases

3]

1)

-] Windows Firew
‘j Network ListM yjayy N
sl Wireless Netw

| Public key Polic  Refresh

| Software Rest  Export List...

_| Network Acces

| Application Cot Help

@ 8, 1P Security Policies on Active Directory (CIEJ

HEBEB

® [] Advanced Audit Policy Configuration
# ol Policy-based QoS
& | Administrative Templates: Policy definitions (ADMX
@ [l Preferences

B 48 User Configuration =
itebe ' Ll_l
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Step 6: On the General tab, give the policy a name and description, and
then make sure Use Windows Wired Auto Config service for clients is
selected.

Step 7: On the Security tab, make sure Enable of IEEE 802.1X authentica-
tion for network access is selected.

Step 8: In the network authentication method drop-down list, choose
Microsoft: Smart Card or other certificate.

Step 9: In the Authentication Mode drop-down list, choose User or com-
puter authentication.

Step 10: Click Properties.
Step 11: Make sure the Use a certificate on this computer option is
selected, and then make sure the Use simple certificate selection and

Validate server certificate check boxes are selected.

Step 12: In the Trusted Root Certification Authorities list, select the check
box next to the root certificate for the CA.

Step 13: Click OK, click Apply, and then click OK again.
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Configure GPOs for wireless endpoints

This deployment uses GPOs to configure the 802.1X supplicant for wireless
endpoints running Windows XP SP3 and higher.

Step 1: On the CA console, navigate to Start > Administrative Tools >
Group Policy Management.

Step 2: Expand the Forest, Domain, local domain, and Group Policy
Objects.

Step 3: Right-click Default Domain Policy. The Group Policy Management
Editor opens.

Step 4: In the Group Policy Management Editor, navigate to Computer
Configuration > Policies > Windows Settings > Security Settings.

Step 5: Right-click Wireless Network (IEEE 802.11) Policies, and then
choose Create a New Wireless Network Policy for Windows Vista and
Later Releases.

-ioix]
File Action View Help

Y EIEEN G

&1 &% Computer Configuration ] [ Name | Desaiption [Type |
E [ Polides
& [ Software Settings
=1 ] Windows Settings
® [ Name Resolution Policy

There are no items to show in this view.

=} Seripts (Startup/Shutdown)
5 T Seaurity Settings
B 35 Account Policies
& g Local Polides
® g Eventlog
E g Restricted Groups
B L4 System Services
7 [ Registry
& ‘_"5 File System
4 Wired Network (IEEE 802.3) Polices
& || Windows Firewall with Advanced Security
| Metwork List Manager Polices

B Vi edess Network (IEEE
® [ ] Public Key Polides
® | Software Restriction Pc
& ] Metwork Access Protec
& || Applicaion Control Polk
# {8, IP Secusity Polideson 4 Refresh
& [ ] Advanced Audit Policy | Export List...
# gl Policy-based QoS
@ [ Administrative Templates: Polic  HE®
@ [ Preferences

= gﬁu;erca'lﬁgu'abon -
Ll I | _'IJ‘I 12
bemammﬂmwuwdmmm

for Windows Vista and Later Releases
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Step 6: On the General tab, give the policy a name and description, and
then make sure Use Windows WLAN AutoConfig service for clients is
selected.

Step 7: Click Add, and then choose Infrastructure.

L
General | Network Permissions |

Settings defined in this policy will apply to all wireless interfaces of dient
machines

Policy Name:
| EAP-TLS (Vista and later)

Description:
B021.X EAP-TLS for Vista and later

¥ Use Windows WLAN AutoConfig service for dients
Connect to available networks in the order of profiles isted below:

Profile Name | sso | Authentication | Encry
e
I"
||
g 4

Infrastructure

Step 8: Give the profile a name, enter the name of the SSID for the wireless
network, and then click Add.

Step 9: Click the Security tab.

Step 10: In the Authentication drop-down list, choose WPA2-Enterprise,
and then in the Encryption drop-down list, choose AES.
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Step 11: In the Select a network authentication method drop-down list,

choose Microsoft: Smart Card or other certificate.

Step 12: In the Authentication Mode drop-down list, choose User or

Computer authentication.

WLAN-Data (EAP-TLS) properties

Select the security methods for this network

FPuthentication:

Encryption:

WFAZ-Enterprise

Select a network authentication method:

| Microsoft: Smart Card or other certficate

Puthertication Mode:

I User or Computer authentication

Max Authentication Failures:

=
—

W Cache user information for subsaguent connections

to this network

x|

oK I Cancel

Step 13: Click Properties.

Step 14: Make sure the Use a certificate on this computer option is
selected, and then make sure the Use simple certificate selection and

Validate server certificate check boxes are selected.

Step 15: In the Trusted Root Certification Authorities list, select the box
next to the root certificate for the CA.
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Step 16: Click OK, and then click OK again.

Step 17: Click Apply, and then click OK.

You also need to create a policy for Windows XP clients.

Step 18: Right-click Wireless Network (IEEE 802.11) Policies, and then

choose Create a New Windows XP Policy.

' Group Policy Management Editor

Fle Acton View Help

e ?mc=HE

(=3}

F & Computer Configuration

= || Poldes
Bl [ Software Setiings
E ] Windows Settings

[ [ ] Name Resolution Policy

|£] Saripts (Startup//Shutdawm)
= g Security Settings

] ﬁ Account Polices

¥l 3 localPoices

[ i Eventlog

f# g Resticted Groups

# q System Services

# 4 Registry

H _g File System

| Network List Manager Polides
)
Fh

iy Wired Network (IEEE 802.3) Polioe
® -] Windows Firewall with Advanced S

2] [ Mame | Desaription | Type

@EAP—TIS (vista and la... 8021.X EAP-TLS for Vista an... Vista and Later Releases

View

# _  Refresh
# 8 Exportlist...

3]
= gl P Help

# || Preferences
b ¢, User Configuration

s

¥ [ Adminstrative Templates: Policy defnmona—l

ol

|Create & new Windows XP wireless group policy

Step 19: On the General tab, give the policy a name and description, and
then make sure Use Windows WLAN AutoConfig service for clients is

selected.
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Step 20: In the Networks to access list, choose Any available network
(access point preferred).

B
General | preferred Networks |

¥P Policy Mame;
| EAP-TLS (XF)

Description:
I 802, 1X EAP-TLS profile for XP| I

Metworks to access:

IAn'.I avalable network (access pont preferred) ;I
¥ Use Windows WLAN AutoConfig service for dients
[T Automatically connect to non-preferred networks

Step 27: In the Authentication Mode list, choose User or Computer
authentication.

2/
'Metwork Properties IEEE 802.1X I
V¥ | Enatie metwork access contral using IEEE 202, 1%
EAP Type:
[mnsnﬂ: Smart Card or other certificate
Eapol-Start Message:
[Transmt :]

Authentication Mode:
|User of Computer authentication :]

W Authenticate as computer when computer information s available

|_ Authenticate as guest when user or computer mformation is

[ ok | concel | apoy |

—IEEE 802. 1
Max Eapol-Start Msgs: Held Period (seconds):
I 3 | 1
Start Period (seconds): Auth Period (seconds]):

e

—

Step 21: Click the Preferred Networks tab.

Step 22: Click Add, and then select Infrastructure.

Step 23: Enter the SSID for the network and give a description.
Step 24: Select WPA2 for Authentication and AES for Encryption.
Step 25: Click the IEEE 802.1X tab.

Step 26: In the EAP type list, choose Microsoft: Smart Card or other
certificate.
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Step 28: Click Settings.
Step 29: Make sure the Use a certificate on this computer option is

selected, and then make sure the Use simple certificate selection and
Validate server certificate check boxes are selected.
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Step 30: In the Trusted Root Certification Authorities list, select the box next
to the root certificate for the CA.

Smart Card or other Certificate Properties x|

~ When connecting:
™ |lse my smart card
% |lse a cedfficate on this computer
¥ Use smple cetificate seection (Recommended)

~ ¥ Validate server cerificate

[ Cass 3 Public Prmary Certfication Authority
O Bquifax Secure Cerificate Authority
] GTE CyberTrust Global Root

0] Microsoft Root Authority

[ Microsoft Roct Certficate Authorty

O thawte Pimary Root CA -
4| | ¥

View Cettficate |
[ Do not prompt userto authorize new servers or frusted cedification

[ Use a different user name for the connection

oK I Cancel

Step 31: Click OK.

Step 32: Click Apply, and then click OK. The Profile Properties window
displays.
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Step 33: Click Apply, and then click OK.

At this point, all endpoints running Windows XP SP3 and later will have a
802.1X supplicant configuration pushed to them the next time they log in to
the domain or after the GPO policy is refreshed.

Deploy AnyConnect on Windows endpoints

1. Install AnyConnect
Install Profile Editor

Create wired profile

> WD

Create wireless profile

Cisco AnyConnect Secure Mobility Client 3.0 can be used as an 802.1X sup-
plicant on Windows endpoints using the Network Access Manager module.
In this example deployment, the Network Access Manager is configured with
both wired and wireless profiles using digital certificates.
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Step 2: Select AnyConnect Diagnostic and Reporting Tool and
Install AnyConnect AnyConnect Network Access Manager, and then clear all of the other
check boxes.
To use Cisco AnyConnect Secure Mobility Client 3.0 as your 802.1X sup-

plicant on Windows endpoints, you need to download the latest version % Cisco AnyConnect Secure Mobility Client Install Selector =% EOR/~<™
from Cisco.com along with the Profile Editor. The client is distributed as an i

ISO image and will need to either be burned to a disk or mounted as a disk Select the AnyConnect 3.0.30

image by using a utility that provides this function. You need to be logged in ;

as an administrator to install AnyConnect Secure Mobility Client. H AnyConnect VPN

U Reader Tip

The latest Cisco AnyConnect Secure Mobility client and Profile AnyConnect Network Access Manager
Editor can be downloaded from: 3

B AnyConnect VPN Start Before Login

AnyConnect Diagnostic And Reporting Tool

http://www.cisco.com/cisco/software/release.htm|?mdfid=28300018 ll AnyConncct Posture

5&flowid=17001&softwareid=282364313&release=3.0.5075&relind=A B AaiContect Talemetcy
VAILABLE&rellifecycle=&reltype=latest i s

B AnyConnect Web Security

Step 1: Start the installer for the AnyConnect Secure Mobility Client by W Sclect All

launching the Setup program on the disk.

B Lock Down Component Services

Install Selected

Step 3: Click Install Selected, verify the components selected to install,
and then click OK.

Step 4: Click Accept to accept the license agreement.

Step 5: After the installation completes, click OK. You may be asked to
restart the computer.
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http://www.cisco.com/cisco/software/release.html?mdfid=283000185&flowid=17001&softwareid=282364313&release=3.0.5075&relind=AVAILABLE&rellifecycle=&reltype=latest
http://www.cisco.com/cisco/software/release.html?mdfid=283000185&flowid=17001&softwareid=282364313&release=3.0.5075&relind=AVAILABLE&rellifecycle=&reltype=latest

Install Profile Editor

Step 1: Locate the Profile Editor Installer downloaded previously, and then
double-click it. The installation process starts.

The installation requires Java Runtime Environment 1.6 or higher. If you don’t
have it installed, you will be prompted to install it.

Step 2: If you are prompted to install Java Runtime Environment 1.6 or
higher, click Next. This installs it.

Step 3: Click Next. The installation of Profile Editor continues.
Step 4: Click Typical, and then click Install.

Step 5: Click Finish. The installation completes.

Create wired profile

Step 1: Launch the Profile Editor by navigating to Start > All Programs >
Cisco > Cisco AnyConnect Profiler Editor > Network Access Manager
Profile Editor.

Step 2: From the File menu, choose Open, and select C:\\ProgramData\
Cisco\Cisco AnyConnect Secure Mobility Client\Network Access
Manager\system\configuration.xml.

Step 3: Click Networks.

February 2012 Series

Step 4: Select the wired profile, and then click Edit.

[y AnyConnect Profile Editor - Metwork Access Manager [=l-o- =]
File Help
}i Network Access Manager Networks

{8} Client Policy ;
Authentication Pokcy Profile: ...ility Client\Network Access Managerisystem\configuration.xml
Netwarks

N Network
% Network Groups .
Marme Media Type Group™
wired Wired Global

dit,

1

m

= A network in group 'Global is a member of afgroups.

Step 5: Enter a name for the profile, and then click Next.
Step 6: Select Authenticating Network, and then click Next.
Step 7: Select Machine and User Authentication, and then click Next.

Step 8: Select EAP-TLS as the machine authentication method, and then
click Next.

Step 9: Enter an unprotected identity pattern for machine identity. In this
deployment, use host.[domain].

Step 10: Click Next.

Step 11: Select EAP-TLS as the user authentication method, and then click
Next.
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Step 12: Enter an unprotected identity pattern for user identity. In this

deployment, use [username]@[domain].

Step 13: In the User Credentials section, select Prompt for Credentials,

and then select Remember while User is Logged On.

Step 14: Select Smart Card or OS certificates as the certificate source,

and then click Done.

[ AnyConnect Profile Editor - Network Access Manager (=2 E=R ==
File Help
|1 Network Access Manager MNetworks
8% Chent Policy - . - .
Authentication Paficy Profile: ...ility ClientiNetwork Access Managerisystem\configuration.xml |
Networks. User Identity Media Type il
F Network Groups Unprotected Identity Pattern: [username] @[domain] Security Level
= Connection Type
Machine Auth
Credentials
| User Auth
User Credentials Credaniials
") Use Single Sign On Credentials =
@ Prompt for Credentals
Remember Forever
(@ Remember while User is Logged On
(71 Never Remember
Certificate Sources Remember Smart Card Pin
@) Smart Card or OS certificates | ¥icharuies ooy
= Smart Card certifi anly ~) Remember whike User is Logged On
@ Never Remember
v T ]
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Create wireless profile

Step 1: Click Add. This creates a new wireless profile.

Step 2: Enter a name for the profile, and then, for group membership, select
In all groups (Global).

Step 3: In the Network Media section, select Wi-Fi (wireless) Network,
enter the SSID of the wireless network, and then click Next.

["4 AnyConnect Profile Editor - Network Acesss Manager = |
File Help
1. Metwork Access Manager Networks
£4 Chent Polcy - ity Cli A " e :
Authentication Policy Profile: ...ility ClientiNetwork gerisy g »n.xm
Metworks MedaType | &
2% Network Groups Name: Wireless-TLS |
Group Membership
In group: (auto-generated)

@ In all groups (Global)
Choase Your MNetwork Media

) Wired (802.3) Network
Select a wired network if the endstations will be connecting to the network with a traditional
ethemet cable,

@ WiFi (wireless) Network
Select a WiFi network if the endstations will be connecting to the network via a wireless
radio connecton to an Access Point.
SSID (max 32 chars): WLAN-Datal

m

[ Hiddan Network
Assodation Timeout (sec) 5
| Common Setings

|
| Saipt or application on each wser's machine to run when connected.

Browse Local Machine

Connection Timeout (sec.) 40

Step 4: Select Authenticating Network, choose WPA2 Enterprise (AES) as
the association mode, and then click Next.

Step 5: Select Machine and User Authentication, and then click Next.

Step 6: Select EAP-TLS as the machine authentication method, and then
click Next.
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Step 7: Enter an unprotected identity pattern for machine identity. In this
deployment, use host.[domain].

Step 8: Click Next.

Step 9: Select EAP-TLS as the user authentication method, and then click
Next.

Step 10: Enter an unprotected identity pattern for user identity. In this
deployment, use [username]@[domain].

Step 11: In the User Credentials section, select Prompt for Credentials,
and then select Remember while User is Logged On.

Step 12: Select Smart Card or OS certificates as the certificate source,
and then click Done.

Step 13: From the File menu, choose Save. This updates the configuration
file.

To deploy the Cisco AnyConnect Secure Mobility Client to
multiple workstations with the same policy, you can create a
customized installation package. You need to copy all the files
from the installation disk to a folder on the hard drive, for example,
C\AnyConnect. Then, follow the procedure above to edit the profile.
Copy the file (C:\ProgramData\Cisco\Cisco AnyConnect Secure
Mobility Client\Network Access Manager\system\configuration.xml)
to C:\AnyConnect\Profiles\nam\configuration.xml.

Copy the contents of C:\AnyConnect to some form of removable
media, for instance, CD, DVD, USB drive, etc.

You can then take this new installer package and run the installa-
tion on a workstation. The custom configuration file is loaded and
ready for use.

At this point, all Windows endpoints now have certificates deployed and are
enabled to use 802.1X authentication. On the wireless network, any device
that doesn't have a certificate uses PEAP to gain access to the network.

February 2012 Series

Monitor mode is running on the wired network, so endpoints that aren’t
configured for 802.1X still get access by using MAC Authentication Bypass
(MAB).

Configure Mac workstations for 802.1X authentication

1. Install root certificate on Mac OS X
2. Request user certificate

3. Configure Mac OS X supplicant

If you have Apple Mac endpoints, you have to manually obtain a certificate
and configure 802.1X authentication. The example deployment shows how
you would do this for Mac OS X 10.6.

Install root certificate on Mac OS X

To install a trusted root certificate on Mac OS X 10.6, you need to manually
request the certificate from the CA and install the certificate in the keychain.

Step 1: On the Mac, browse to the CA at http://ca.cisco.local/certsrv.

Step 2: Make sure the current certificate is selected and the DER encoding
method is selected.

Step 3: Click Download CA Certificate, and then save the certificate file.

Step 4: Locate the certificate file, and then double-click it. This launches
the Keychain Access utility.
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Step 5: Click Always Trust.

You may be prompted for credentials of a user with permission to
change the certificate trust settings.

n Do you want your computer to trust certificates signed by “cisco-
AD-CA" from now on?
‘é% This certificate will be marked as trusted for the current user only. To

change your decision later, open the certificate in Keychain Access and edit
its Trust Settings.

=

I cisco-AD-CA
(Certifiectie
Bl ) Root certificate authority

‘.| Expires: Tuesday, October 18, 2016 1:27:28 PM ET
€3 This root certificate is not trusted

» Trust
» Details

C Hide Certificate j

CDon't Trust j E—Ahayﬁmsl-}
P
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Request user certificate

Next, you need to obtain a user certificate for the Mac. To do this, first you
need to generate a certificate signing request, and then request the certifi-
cate from the CA.

Step 1: In the Keychain Access utility, from the Keychain Access menu,
choose Certificate Assistant > Request a Certificate from a Certificate
Authority.

ﬂl(eyl:hainm:r.ess File Edit View Window Help

About Keychain Access Keychain Access

Preferences... £ Q

. Keychain First Aid N#A
Open...

Ticket Viewer LEK Create a Certificate...
S Create a Certificate Authority...
Services »  Create a Certificate For Someone Else as a Certificate Authority...
Ty e —
Hide Others ~CsH Set the default Certificate Authority... I

Show All Evaluate a Certificate...
!

- Quit Keychain Access ®Q

Step 2: In the Certificate Assistant, enter your email address and common
name (typically the user's first and last names), select Saved to Disk, and
then click Continue.

Certificate Information

Enter information for the certificate you are requesting.
Click Continue to request a certificate from the CA.

User Email Address: |taylorsmith@cisco.local _ﬂ

Common Name: Taylor Smith

CA Email Address: I ]

Request is: () Emailed to the CA
® Saved to disk

] Let me specify key pair information
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Step 3: Enter a file name and location, and then click Save.

Step 4: Click Done.

Step 5: On the Mac, browse to http://ca.cisco.local/certsrv. When you
authenticate to the CA, be sure to authenticate as the user for which you
wish to obtain a certificate.

If you still have the browser window open from when you down-
loaded the trusted root certificate, click Home in the upper right
corner to go back to the main page of the CA.

Step 6: Click Request a certificate.
Step 7: Click advanced certificate request.

Step 8: Open the certificate request file saved in Step 3 in a text editor,
such as TextEdit, select all the text, and then copy it to the clipboard.

Step 9: Paste the contents into the text box in the Saved Request section of
the certificate request that is open in the browser.
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Step 10: In the Certificate Template drop-down list, choose User, and then
click Submit.

Microsoft Active Di

Submit a Certificate Request or R I R

To submit a saved request to the CA, paste a base-64-encoded CMC or PKCS #10 certificate request or PKCS #7 renewal request
generated by an external source (such as a Web server) in the Saved Request box.

Saved Request:

'tmGBqRIR4XgBimHZwZ 1M611DiqhgXy 1VMKS II30v —
Base-64-encoded okaRmWiE6MpArb0o1AIZIMWFHE +0sanrhwwmsxDL
certificate request | LFV49197X0PzpKiBkk0sUdOtMOrEEQLlStEJDOQN

(CMC or H2vnd0QdsuL¥q+meq0C3/0qwieyndbI YEQPSGpST
PKCS #10 or 6eCoSzgxNBDOgzAjcJoGEISABNIrEL9 3HNQFzFue,
PKCS #7)  m==== END CERTIFICATE REQUEST----- v
[ ] y<vl 4
s
Altributes: /J
-subm\l >

Step 11: Select DER encoded, and then click Download certificate. This
saves the certificate.

Step 12: Locate the saved certificate in Finder, and then double-click it to
import it into the Keychain Access utility.

Step 13: In the Keychain drop-down list, choose login, and then click Add.

Cortglocte Do you want to add the certificate(s) from the file
P “certnew.cer” to a keychain?

Keychain: [ login H-q

( Cancel :l (-——'Md"—-)

( View Certificates )
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Configure Mac OS X supplicant

Step 1: On your Mac, launch System Preferences.
Step 2: Double-click Network.
Step 3: Click Advanced, and then click the 802.1X tab.

Step 4: Click the + symbol and select Add User Profile.

Nolele) Network

| AirPort  TCP/IP  DNS WINS | 802.1X @ Proxies FEthernet

User Name:

Password:

Authentication: = Enable | Protocol
TTLS
TLS
EAP-FAST
PEAP

e - ]

Configure. ..

Configure Trust...

Wireless Network:

qbll,l

Security Type: = WPA2 Enterprise

Add User Profile

Add Login Window Profile
® Add System Profile

Step 5: Give the profile a name, and then enter your user name and
password.

Step 6: In the Authentication section, select TLS, and then click Configure.

Step 7: Select the certificate for this user, and then click Continue.
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Step 8: For wireless connections, choose the wireless network from the list,
and then choose WPA2 Enterprise for the Security Type.

=" AirPort

Cl

| AirPort = TCP/IP DNS WINS | 802.1X | Proxies Ethernet '

¥User Profiles
# WLAN-Data

User Name: taylorsmith

Password: essesses

|| Always prompt for password

Authentication: | Enable  Protocol
O TTLS

[ PEAP

[ EAP-FAST =

( Configure Trust...

Wireless Network: |WLAN-Data ﬁ
= Security Type: [ WPA2 Enterprise H']

® (Cancel) ( OK )

Step 9: Click OK, click Apply, and then exit System Preferences.

Repeat this process for all Mac OS X endpoints to deploy certificates and
to enable 802.1X authentication. On the wireless network, any device that
doesn’'t have a certificate uses PEAP to gain access to the network. Monitor
mode is running on the wired network, so endpoints that aren't configured
for 802.1X still get access by using MAC Authentication Bypass (MAB).
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Monitoring

1. Cisco ISE Dashboard

Configure identity groups

Add a custom profile

Examining the authentication log
Create custom authentication reports

Identify endpoints

N o o s N

Create device type reports

The configuration of the network infrastructure is complete. Now it's time to

answer the what/when/where/who questions regarding network access by

using the reporting functionality of Cisco ISE to gain a better understanding
of current activity on the network .

Cisco ISE is now configured to authenticate users and to profile endpoints
based on RADIUS and DHCP information. The reporting capabilities of
Cisco ISE allow you to determine what type of device is connecting to your
network, when it connects, and where it connects from. Also, you will know
who is connecting to your network and what authentication method was
used.
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Cisco ISE Dashboard

The first place to view this information is on the Cisco ISE Home Dashboard.
It gives a summary view of the health status of the servers in the group, how
devices are authenticating, and what types of devices have been profiled.

Step 1: Onthe menu bar, click Home. Each section can be expanded by
clicking the upper-right corner.

CISCO  Identity Services Engine sl admin  Logout  Fesdback
Adrmiristration ¥ © Task Navigatar = €3
Metrics =3
Active Endacints Active Guests Pasture Compliance Mean Time Ta Remediste Profiled Endpoints
3 0 0% 0.0 sec. 2
il 1 o2~ T — 2 AT zahw
System summary G Identity Stores (FIP) O Authentications [
b Utilization and Lateney 246 ~ Name: Authentications 2l + R -
Py i Late - ota R
. Ry ency R Intemnal Endpoints Jlatminan, 175 Laze 24 Hours Last 60 Minutes
& o Nl 17
2 '
B ez
Authentication Failre T Profled Endpoints O Posture Compliance [
Total 9 | - | Unique 2 | Passed 0%
Lazt 24 Hours Lazt 60 Minure= Lazt 24 Hours Lazt 0 Minutes
MTTR  0.0sec
Distribution By: Distribution by: Last 24 Hours Last 60 Minutes
ise-1 [ 2 PN (b B awibih Distribution of Failurs byt
Profile - o3 Mo Data Available
1dentity Group [ 2 Reason M Data Available
€ help Alarms @ 3 4 0@ 2 | £ Notifications (0)
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Configure identity groups

Cisco ISE has more in-depth reporting options to give more details on the
devices connecting to the network. To help identify the endpoints, you can
use identity groups to classify profiled endpoints and to generate reports.

The example below describes how to do this for an Apple iPad. The proce-
dure for other types of devices is similar.

Step 1: In the menu bar, mouse over Policy, and then choose Profiling.
Step 2: Click Apple-iPad. This enables you to edit this policy.

Step 3: Select Create Matching Identity Group, and then click Save.

ise-l adwin  Logout  Feedback

©0 Task Navigator ~ €3

|£) Authentication  [#) Authorization | |-5) Prafing | @) Posture [0 Clent Provisoning | 5) Security Group Access @, Policy Elements

Profler Pelicy Lis - Appla-iPad

Profiler Policy

5. “mame [Apple-Pad | Descipton | Poliey for pple Pads
Policy Enabled !
* Mirimum Certainty Factor {valid Range 1 to 65535)

* Exception Action

* Network Scan (NMAP) Action

@ Create Matching Identity Group
O use Herarchy

p
Profiling

» [ Profilng Policies

* Parent Policy | Apple-Device M
o Ruies
Condition | Apple-PadRule2Check? < | Then [ Certainty Factor Increases RIES || & ~
+If Condition | (apple-iFadRulel Check1_AND_Apple-MacBo, < | Then [ certanty Factor Increases -]
w -
Save Reset |

You can repeat these steps for other endpoint types as needed. You can
also investigate the rules used to profile the endpoint to understand the
process. In the case of the Apple iPad, Cisco ISE uses two rules. One is
based on DHCP information, and the other is based on HTTP.

February 2012 Series

Add a custom profile

Although there are many pre-defined profiles, you may find that a device
you want to profile doesn’'t have an existing profile. You can create a new
one using unique characteristics of the device. Review some of the existing
profiles to get an idea of the options and methods available to you for device
profiling.

The example below creates a profile for the Cisco Cius using information
obtained from the device’'s DHCP request.

Step 1: Connect to https://ise-1.cisco.local.

Step 2: Mouse over Policy, and then, from the drop-down menu, and
choose Profiling.

Step 3: Click Create.
Step 4: Give the policy the name “Cisco-Cius” and a description.

Step 5: In the rules section, next to Conditions, click the + symbol, and then
click Create New Condition (Advance Option).

Step 6: In the Expression drop-down list, next to DHCP, click the > symbol,
and then select dhcp-class-identifier.

aluli
CISCO  Identity Services Engine

Ise-l  admin  Logout  Fesdback

¢ 90 Task Navigator » €

f Home Cperatins ¥ Poicy

|2) Authentication  [9) Authorization | |4 Profing | [®) Postue  [5) Cient Provisioning [ Security Group Access &, Policy Elements

Profiler Policy List = Newe Profiler Policy DHEP

) >
Profiling Profiler Policy 2

( 2] T T R— |

& == . B — : :|

» [ Profiing Policies Palicy Enabled ¥ w client-fodn il
“Mnmum Certanty Factor (10| u clent-dentfier
* Exception Action U device-class
* Network Scan (MMAP) Action 4 dhep-class-identifier

dhep-client-identifi
@ Create Matching Identity Group | CePetentenner
O Use Herarchy

* Parent Palicy | NONE -

1 dhep-message-type

u dhepp q
1 dheprequested-address
u dhep-user-class-id

« Rules
- U domain-name

o IfCondition | Condifions = | Then [ Certainty Factor Incré: & host-name

Condition Name Expression

[ suomt [select attibute © | [ I
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Step 7: In the second drop-down list, choose CONTAINS, and then, in the
final box, enter Cisco Cius.

Step 8: Choose Certainty Factor Increases, set the value to 20, and then
click Submit.

oo
CISCO  Identity Services Engine sl admin Logout Feedback

f o Task Navigator ~ €3

f Home Cperations ¥ Poicy v Administration v

|5) Authentication  [g] Authorization [ 4] Profiing | [ Posture  [6) Client Provisioning | Security Group Access g% Policy Elements

Brofier Folicy List > News Profiler Policy

Profiling Profiler Policy

( £
- = L *Name [ Cisco-Clus Description | Cisco Cius
» [ Profilng Policies Policy Enabled [
* Minimum Certainty Factor (valid Range 1 to £65535)
* Exception Action
* Network Scan (MMAP) Action
@® Create Matching Identity Group
O Use Herarchy

* Parent Palicy | NONE -

«  Rules
p

If Condition \ DHCP_dhep-class-identifier CONTAINS_Cisco. & |Then [ certainty Factor Increases -

=
==y

Examining the authentication log

Step 1: On the menu bar, mouse over Monitor, and then choose
Authentications. The authentication log displays. The default option is to
display the last 20 records from the last 24 hours.

For devices that authenticated via MAB, the MAC address of the client is
listed as the user name and the endpoint. For device that authenticated via
RADIUS over wireless or VPN, the user name is displayed.

If the device was able to be profiled, that information is displayed.
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Step 2: In the details column of the MAB record, click the “paper with
magnifying glass” icon. This displays detailed authentication information for
the record.

In the Authentication Summary section, the network device lists the IP
address and the port of the switch that the endpoint is connected to.

cisco  |dentity Services Engine -
ENERE] Launch Interactive Viewer F
RADIUS Authentication Details
Showing Page 1 of 1 | Goto Page: Go
AAA Protocel » RADIUS Authentication Detail =
RADIUS Audit Session ID : 0AD52C0600000001B4E846C6
ALA session ID ise-1/112681645/20
Date December 132011
Generated on December 13, 2011 1:44:33 PM PST
Actions
Troubleshoot Authentication =7
Wiew Diagnostic Messages
Audit Netwark Device Confiquratian ™
Wiew Network Device Configuration =
Wiew Server Configuration Changes
Authentication Summary
Logged At December 13,2011 11:42:30.740 AM
RADIUS Status: Authentication succeeded
NAS Failure:
Usernarme Ef:04:62:EA G390
MAC/IP Address E6:04:62:EAB3:90
Ietwork Device DefaulthetworkDevice : 10.5.44.5 : GigabitEthermet1/0/1
Allowed Protocol Default Metwork Access
Identity Store!
Authorization Profiles:  PermitAccess
SGA Security Group:
Authentication Protocal : Lookup =
4] |_’|—I
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You can find additional details, such as the Identity Group and Identity
Policy, in the Authentication Details section.

cisco  Identity Services Engine -
EFEE] Launch Interactive Viewer 7]
RADIUS Authentication Details
Showing Page 1 of 1 Goto Page: Go
=F, Details d
Logged At December 13,2011 11:42:30.740 AM
Occurred At December 13,2011 11:42:30.740 AM
Server. ise-1
/Authentication Method: mab
EAP Authenticaion Methad Lockup

EAP Tunnel Method
Usemarne

RADIUS Usemarme

Calling Station D

Framed IP Addres:

Use Case,

Network Device:

Network Device Groups:
NAS IP Address:

NAS Identifir

NAS Port

NAS Port ID.

NAS Port Type:

Allowed Protoc ol

Senice Type

Identity Store:

Authorization Profes:

Active Directory Domain
Identity Group:

Allowed Protoc ol Selection Matched Rule:
Identity Policy Matched Rule
Selected dentity Stores:
Authorization Policy Matched Rule:
SGA Security Group

ABA Session ID:

Audit Session ID:

Tunnel Details:

Cisco-AVPairs,

Other Attributes:

Pasture Status.
EPS Status:

EB.04.62.EA 8390
EB:04:62:EA 83:90
EB:04.62.EA 390

Host Lookup

DefaultetworkDevice

Device Type#All Device Types Location#All Locations
105445

50101
GigabitEthemet 1701
Ethernet

Defalt Network Access
Call Check

PermitAccess

MAB
Default
Irternal Endpoints
Default

ise-1/112681645/20
0AD52C0500000001 B4BB4ECE

senicedype=Cal Check
audit-ses sion-id=0A152C0500000001 B4BB4B CE

c D |
Key-Narne= CPM ID=0A52C0500

Framed-MTU= 1500 EAP-

0462-E

Type=Desice TypeAll Device Types,Locatian=Location#All Lo

ID=EC:CE:82:37:59.01
MotApplicable

8,EndP

intA 90|
cations Device P Address=10.5.44.5 Called- Station-

Device

<l

por”

Similar data can be found for endpoints that have authenticated with
RADIUS. The user name is displayed in these records as well the EAP

method used.
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Create custom authentication reports

The default authentication log view is limited to displaying only the most
recent entries. To get in-depth reporting, you need to create a custom
report.

Step 1: On the menu bar, mouse over Monitor, and then, in the Reports
section, choose Catalog.

Step 2: Inthe left pane, select AAA Protocol.
Step 3: Select RADIUS Authentication.

Step 4: Click Run. Different time ranges for producing the default report are
displayed. For time ranges not listed, choose Query and Run.

am
€Isco  Identity Services Engine ise-l admin  Logout  Feedback

Admiristration v ©0 Task Navigator » €3

—
BN Authentications g Endpoint Protection Service £ Alarms  Reports | e, Troubleshoot

Faworites  Shared [(Catdlog | System

AAA Protocol

Reports
U AAA Protocol
u Alaved Pratocal Fier [ Go | ClearFitter
& Server Instance
Report Name < Tyoe Modified At
Endpoint

u Endpont O ARA Diagnostics System Report Mon Feb 27 23:41:08 PST 2012
u Faiure Reason O Authentication Trend System Report Mon Feb 27 23:41:08 PST 2012
B Metwork Device  RADIUS Accounting System Report Maon Feb 27 23:41:08 PST 2012
v | €. BADS Auherieston
. Security Group Access Run ~| AddToFaverite | Delete Reset Reports
1 Session Drectary Last 30 Min
o Fosture Last Hour of type 'System Report, hover mouse over the 'Report Narme' to view the report description
& Endpeint Pratectien Service Last12HOUIS hoport Name! to run report for today.

aday leport and click on 'Run' button to select additional options

Yesterday

Last 7 days

Last 30 days
Query And Run
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Step 5: If you choose Query and Run, all the parameters available for the
report display. After choosing the parameters you want, click Run to gener-
ate the report.

Figure 2 - RADIUS report parameters
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Identify endpoints

Using information gleaned from the RADIUS and DHCP requests, Cisco ISE
can identify what types of devices are connecting to the network. This can
assist in determining network security policy based on the type of device
thatisin use.

Step 1: On the menu bar, mouse over Monitor, and then, in the Reports
section, choose Catalog.

Step 2: In the left pane, click Endpoint. This displays the available endpoint
reports.

Step 3: Select Endpoint Profiler Summary, and then click Run,

Step 4: Select the desired time period to run the report.

alvln
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Last7das b ot Name' to run report for today.
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Step 5: Once the report is generated, you can view the details of a profiled
endpoint by clicking the magnifying glass icon.

The details given in the summary section are the MAC address, the endpoint
policy, and the identity group for the endpoint. Additional details such as IP
address and network access devices are available in the Endpoint Details
section. For wireless and remote access VPN endpoints that authenticated
with RADIUS, the user name is also listed.

Figure 3 - Endpoint profile summary
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Figure 4 - Endpoint Details
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Create device type reports

You can create reports to identify specific devices based on the identity
groups configured previously. This example uses the group created to
identify Apple iPads.

Step 1: On the menu bar, mouse over Monitor, and then, in the Reports
section, choose Catalog.

Step 2: In the left pane, click AAA Protocol.
Step 3: Select RADIUS Authentication.

Step 4: Click Run, and choose Query and Run.
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uthentications i@ Endpoint Protection Service T Alams | Reports

"4, Troubleshoat

st adnin Logout  Feedback

0 Task Mavigator ~ €3
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W Server Instance
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@ Faiure Resson
1 Hstwork Device.

o User

AAA Protocol

Filter: Go | _ClearFiter

€ RADIUS Acsounting

Report Name - Type Modified At
€ #AA Diagnostics System Renort Mon Feh 27 23:41:09 PST 2012
€ putrentication Trend Systern Report Mon Feh 27 23:41:00 PST 2012

System Renort

Mon Feh 27 23:41:08 PST 2012

1 Sexury Group Access Run ~| Add To Favorite | Delets | ResstRepots |

& Session Directory. Last 30 Win

w Fosture Last Hour of type 'System Report, hover mause aver the 'Report Name' to view the report description
 Endpoint Protection Service LeRiR e
Today
‘Yesterday
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Query And Run

epart Name' o run report for today.
lepart and click on 'Run’ button to select additional options

Step 5: Click Select next to the Identity Group field for the identity group
you want to query. A search window appears.

Step 6: Leave the search field empty and click Select to search all groups.
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Step 7: Select the group Profiled:AppleiPad, and then click Apply.

Search Filter: | Searchl

Criteria
Blacklist |

Guest
Profiled
Prafiled:Andraid o

N © EeREe TS B’

FProfiled:Apple-iPhane

Apply | Cancel |

@ Select ldentity Groups

Step 8: Select a time range for the report, and then click Run. The report
generates.

Figure 5 - Sample report
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Appendix A: Product List

The following products and software versions have been validated for the Cisco Smart Business Architecture.

Functional Area

Product

Part Numbers

Software Version

Network Management

Cisco ldentity Services Engine
Virtual Appliance

ISE-VM-K9=

L-ISE-BSE-2500=

Cisco Identity Services Engine 2500 EndPoint Base License
L-ISE-BSE-3500=

Cisco Identity Services Engine 3500 EndPoint Base License
L-ISE-BSE-5K=

Cisco Identity Services Engine 5000 EndPoint Base License
L-ISE-BSE-10K=

Cisco Identity Services Engine 10000 EndPoint Base License
L-ISE-ADV3Y-2500=

Cisco ISE 2500 EndPoint 3Year Advanced Subscription License
L-ISE-ADV3Y-3500=

Cisco ISE 3500 EndPoint 3Year Advanced Subscription License
L-ISE-ADV3Y-bK=

Cisco ISE 5000 EndPoint 3Year Advanced Subscription License
L-ISE-ADV3Y-10K=

Cisco ISE 10000 EndPoint 3Year Advanced Subscription License

1.1.0.665
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Functional Area

Product

Part Numbers

Software Version

Network Management

Cisco Prime LAN Management
Solution

LMS-4.1-100-K9

LMS 4.1, networks of up to 100 devices

LMS-4.1-500-K9

LMS 4.1, networks of 100 to 500 devices
LMS-4.1-1K-K9

LMS 4.1, networks of 500 to 1000 devices

LMS-4.1-2.5K-K9
LMS 4.1, networks of 1000 to 2500 devices

441

Access Layer for PC,
phones, APs, other devices

Catalyst 2960S

Stackable Ethernet 10/100/1000
ports with PoE+ and Stack Module

WS-C2960S-24PD-L

Catalyst 29608 24 GigE PoE+, 2 x 10G SFP+ LAN Base
WS-C2960S-48FPD-L

Catalyst 29608S 48 GigE PoE +, 2 x 10G SFP+ LAN Base
WS-C2960S-24PS-L

Catalyst 2960S 24 GigE PoE+, 4 x SFP LAN Base
WS-C2960S-48FPS-L

Catalyst 29608 48 GigE PoE+, 4 x SFP LAN Base
C2960S-STACK=

Catalyst 29608 Flexstack Stack Module

12.2(58)SE1
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Functional Area

Product

Part Numbers

Software Version

Access Layer for PC,
phones, APs, other devices

Catalyst 3560X

Ethernet 10/100/1000 ports with
PoE+ and Uplink Module

WS-C3560X-24P-S

Catalyst 3750 24 10/100/1000T PoE + and IPB Image
WS-C3560X-48PF-S

Catalyst 3750 48 10/100/1000T Full PoE + and IPB Image
C3KX-NM-1G

Catalyst 3750X 1Gig SFP Uplink Module

C3KX-NM-10G

Catalyst 3750X 10Gig SFP+ Uplink Module

12.2(58)SE1

Access Layer for PC,
phones, APs, other devices

Catalyst 3750X

Stackable Ethernet 10/100/1000
ports with PoE+ and Uplink Module

WS-C3750X-24P-S

Catalyst 3750 24 10/100/1000T PoE + and IPB Image
WS-C3750X-48PF-S

Catalyst 3750 48 10/100/1000T Full PoE + and IPB Image
C3KX-NM-1G

Catalyst 3750X 1Gig SFP Uplink Module

C3KX-NM-10G

Catalyst 3750X 10Gig SFP+ Uplink Module

12.2(58)SE1

Access Layer for PC,
phones, APs, other devices

Catalyst 4507R+E
Dual Supervisors

Dual Power Supplies

WS-C3750X-24P-S

Catalyst 3750 24 10/100/1000T PoE + and IPB Image
WS-C3750X-48PF-S

Catalyst 3750 48 10/100/1000T Full PoE + and IPB Image
C3KX-NM-1G

Catalyst 3750X 1Gig SFP Uplink Module

C3KX-NM-10G

Catalyst 3750X 10Gig SFP+ Uplink Module

12.2(54)SG1
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Functional Area Product Part Numbers Software Version

VPN (Internet Edge 5K) ASA 5510 or ASA 5520 or ASA 5540 | ASA5510-AIP10-SP-K9 8.4.1
ASABE520-AIP20-K9
ASABE540-AIP40-K9

VPN (Internet Edge 10K) 2x ASA 5520 and 500 SSL seatsor | ASA5520-SSL500-K9 8.41

2x ASA 5540 and 1000 SSL seats ASAB5540-SSL1000-K9

Wireless LAN 5508 Wireless LAN Controller AIR-CT5508-100-K9 71910

5508 Wireless LAN Controller with 100 AP license
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